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Preface 
The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 
Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the 
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation 
folder available on your network from which you can access the Oracle|Agile documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. 
This program can be downloaded from the Adobe Web site (http://www.adobe.com). 

The Oracle Technology Network (OTN) Web site 
(http://www.oracle.com/technology/documentation/agile.html) can be accessed through Help > 
Manuals in both the Agile Web Client and the Agile Java Client. If you need additional assistance or 
information, please contact support (http://www.oracle.com/agile/support.html) 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please 
have ready the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Documentation Accessibility  

Our goal is to make Oracle products, services, and supporting documentation accessible, with good 
usability, to the disabled community. To that end, our documentation includes features that make 
information available to users of assistive technology. This documentation is available in HTML 
format, and contains markup to facilitate access by the disabled community. Accessibility standards 
will continue to evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be accessible to 
all of our customers. For more information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/ http://www.oracle.com/accessibility/.  

Readme 

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html). 

Agile Training Aids 

Go to the Oracle University Web page 
(http://www.oracle.com/education/chooser/selectcountry_new.html) for more information on Agile 
Training offerings. 
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Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  





 

Chapter 1 

Introduction 

This chapter includes the following: 

 About Agile Portlet Services ................................................................................................................................ 1 
 What’s New.......................................................................................................................................................... 3 
 IBM WebSphere Portal Server ............................................................................................................................ 3 
 Portlet Communication and Collaboration ........................................................................................................... 3 

 
 

About Agile Portlet Services 
A portal is a Web site that provides internal and external users with a single point of access to a 
company’s Web-based resources. The portal’s single sign-on provides access to any number of 
small applications, called portlets, that let users manage various types of information. Users can 
personalize their own portal pages, making the portal more efficient, usable, and highly tailored to 
meet their individual needs. 

A portal usually contains several portlets. Each portlet provides users access to specific content or 
actions. Agile provides several predefined portlets that can be integrated with a company’s portal. 
Agile Portlet Services expose commonly-used Agile PLM functionality through a company’s portal 
and allow users to quickly link to specific Agile product content. 

The following figure shows a simplified portal system, one that does not include load balancers, 
application server clusters, proxy Web servers, or LDAP servers. 

Simplified portal system 

Portal
Clients

Agile Application Server WebSphere Portal Server

HTTP(s)

Database Server

HTTP(s)
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Agile Portlet Services includes the following portlets: 

Agile Portlets 

Category  Port le t  Descr ipt ion 

Search Advanced Search Searches for Agile PLM objects by matching one or more 
field values. 

 Quick Search Searches for Agile PLM objects by specifying a single 
matching value. 

 Saved Search Displays results for a saved search. 

 Search Folder Browser Allows you to browse search folders and select a 
particular search to run. 

 Search Results Works in conjunction with Advanced Search, Quick 
Search, and Search Folder Browser portlets. When you 
click a search in search portlet, the results appear in the 
Search Results portlet. 

Content Attachment Files Shows a selected Attachments table for objects. 

 Business Object Shows an Agile PLM business object (such as an item or 
change) to view or modify its fields. 

Productivity My Notifications Shows the current user’s Agile PLM notifications. 

 My Things to Do Shows lists of things the current user needs to complete, 
including Action Items, Program Activities, Requests, and 
Workflow Routings. 

Utility Bookmarks Shows the current user’s Agile PLM bookmarks. 

 Clipboard Lets you collect Agile PLM objects to later perform 
actions on them. 

 Quick Links Lets you add links to other portal pages or to external 
Web pages. 

 Quick Navigation Lets you navigate to bookmarked or recently visited Agile 
PLM objects, or display the contents of the Clipboard. 

 Report Folder Browser Lets you generate a report from one of the Report 
folders. 

 Single Signon Allows you to enter a user ID and password to enable 
single signon between the portal and the Agile PLM 
server. 

 Upload File Adds a new file to the Agile PLM system. 

 User Profile Lets you view and edit your Agile PLM user profile 
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What’s New 
Agile Portlet Services provides the following new features with Agile PLM 9.2.2.3: 

 Multiple Values Selection -The User can now filter available values based on string criteria. 

 Advanced Search Portlet - The User can now select multiple values to search on a single list field. 

 My Bookmarks and Quick Navigations Portlets - The User can now select the folder that the 
bookmark will be added. The User can create a new folder and delete bookmarks and folders. 

 My Things to Do Portlet - This portlet now has My Request. 

 My Notifications and Requests Portlet - This portlet is now named My Notifications. The Request 
portion was moved to the My Things to Do Portlet. 

 

 nter URL. 
 

IBM WebSphere Portal Server 
Agile Portlet Services are currently supported on IBM WebSphere Portal Enable for Multiplatforms 
5.1.0.4 and IBM WebSphere Portal Express. 

For complete WebSphere Portal installation instructions, hardware and software requirements, and 
configuration and troubleshooting information, please see the IBM WebSphere Portal InfoCenter. 
Use any of the followin  methods to access the IBM WebSphere Portal InfoCenter: g

 InfoCenter here Portal installation program. Click the  button available in the WebSp

Go to the WebSphere Portal InfoCe
WebSphere Portal Enable 5.1.0.4: 
http://publib.boulder.ibm.com/infocenter/wpdoc/v510/index.jsp 

 WebSphere Portal Express 6.01: http://publib.boulder.ibm.com/infocenter/wspshelp/index.jsp 

 ortal is installed, click Start > All Programs > IBM WebSphere > Portal Server > 
Information Center. 

Portlet Communication and Collaboration 
 

e search results, the object’s contents can appear in a Business Object 

Note 

After WebSphere P

 

Agile portlets communicate with each other using portlet actions and portlet messages. The portlets
work together to share information with each other. For example, the Search Results portlet works 
with one of the Search portlets (such as the Quick Search portlet) to display a table of search 
results. If you click one of th
portlet on the same page. 

You can control whether Business Object portlet clears the portlet of its contents if the 
message received from another portlet (such as a Search portlet) is not supported. For 
more information, see Setting Agile Portlet Parameters (on page 19). 
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Chapter 2 

Installing and Upgrading Agile Portlet Services 

This chapter includes the following: 

 Installation Sequence .......................................................................................................................................... 5 
 Installing IBM WebSphere Portal......................................................................................................................... 6 
 Installing Agile Portlet Services ........................................................................................................................... 10 
 Setting Agile Portlet Services Application Parameters ........................................................................................ 11 
 Setting Up the Agile Portlet Configurator............................................................................................................. 14 
 Configuring the JNLP MIME Type ....................................................................................................................... 16 
 Upgrading Agile Portlet Services to Agile PLM 9.2.2.3........................................................................................ 17 
 Using the XML Upgrade Tool .............................................................................................................................. 17 
 Updating Agile Portlet Services ........................................................................................................................... 18 
 Clearing the Agile SDK Cache............................................................................................................................. 18 
 Setting Agile Portlet Parameters.......................................................................................................................... 19 
 Creating Portal Pages.......................................................................................................................................... 24 
 Agile PLM Administration Settings Related to Portlets ........................................................................................ 27 

 
 

Installation Sequence 
These instructions assume you have purchased the required hardware and software, and installed 
IBM WebSphere Portal as well as Agile PLM 9.2.2.3 before beginning to install Agile Portlet 
Services. 

To install and configure Agile Portlet Services: 

1. Install Agile PLM 9.2.2.3 and all its server-side components (database, file server, LDAP 
server, and so on). Agile Portlet Services connect to the Agile Application Server and cannot 
work without it. 

For detailed instructions on how to install the Agile Application Server, see the separate Agile 
PLM installation guide. 

2. Install IBM WebSphere Portal on a separate server from the Agile Application Server. 

3. Install Agile Portlet Services (AgilePortletPack2.war) on the WebSphere Portal Server. 

4. Configure Agile Portlet Services application parameters. 

5. If you are not using an LDAP server to authenticate users, create portal users and user groups. 
Otherwise, configure the Portal Server to use an LDAP server for authentication. 

6. Set up the Agile Portlet Configurator on a Web server so that portlet administrators can launch 
it to configure portlets easily. 

7. Create separate portal pages that use the Agile portlets. Some Agile portlets require 
configuration before they can be used. 
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Note On one portal page, you must add the Agile Single Signon portlet. Portal users 
can then personalize the portlet to log into the Agile PLM server. Otherwise, 
portal users won’t be able to use the Agile portlets. 

8. Configure each of the Agile portlets, especially those based on the Business Object portlet. For 
Business Object portlets, you can edit each portlet’s XML configuration or use the separate 
Agile Portlet Configurator application. 

Note The WebSphere Portal Server XML configuration interface can be used to 
transfer the configuration of one portal to another. This is useful when moving 
from a development environment to a production environment. For more 
information about the XML configuration interface, see Exporting and 
Importing Portal Configurations using the XML Configuration Interface (on 
page 46), as well as the IBM WebSphere Portal InfoCenter. 

 

Installing IBM WebSphere Portal 
Because WebSphere Portal ships with multiple software components and works with other 
database, Web server, and LDAP server products, there are many different installation scenarios. 
For complete installation instructions, please see the IBM WebSphere Portal InfoCenter. 

To install WebSphere Portal: 

Insert the WebSphere Portal Setup CD and follow the onscreen instructions. 

Important Do not install WebSphere Portal Server into a path with spaces (such as “d:\Program 
Files\WebSphere”). 

 

Updating to WebSphere Portal 5.1.0.4 

If you are running WebSphere Portal 5.1, you should run two separate fix packs from IBM to update 
to WebSphere Portal 5.1.0.4. Click the following links to download the fix packs: 

 WebSphere Portal 5.1 Cumulative Fix 1 

 WebSphere Portal 5.1 Cumulative Fix 2 

You can also download these fix packs by going to the IBM web site (http://www.ibm.com/us/). 
Search for “WebSphere Portal 5.1 Cumulative Fix 1” and “WebSphere Portal 5.1 Cumulative Fix 2” 
(both in quotes). 

Installing WebSphere Application Server and IBM HTTP Server as a 
Windows Service 

If you are going to run WebSphere Application Server and IBM HTTP Server (if you are installing it) 
as a Windows service, you must install the product as a user with the following local policy rights: 

 Act as part of the operating system 

 Log on as a service 

The WebSphere Portal installer assigns these local policy rights to your account automatically, but 
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you will need to log out and log in again before continuing the installation. 

Web Server Considerations 

You can install the Web server on the portal machine or on a separate machine. If you install the 
Web server on a remote server, you should also consider installing the WebSphere Application 
Server plug-in, which takes care of load balancing between remote Application Server instances in 
a clustered environment. The plug-in will also allow you to change the WebSphere Portal URI. 

For more information about WebSphere Application Server plug-in, see the IBM WebSphere Portal 
InfoCenter. 

WebSphere Application Server Tuning 

After you install WebSphere Portal Server, you should tune the installation of WebSphere 
Application Server to optimize performance. 

Use the WebSphere Application Server administrative console to tune the server. 

To access the WebSphere Application Server administrative console: 

1. Stop the WebSphere Portal Server. 

2. Start the WebSphere Application Server. 

3. In a Web browser, type the following URL: 

http://<fully_qualified_hostname>:9090/admin 

where <fully_qualified_hostname> is the fully qualified host name of the server running the 
WebSphere Application Server. 

4. Log in using the administrative user ID and password. 

5. Tune the WebSphere Application Server using the recommended settings in the table below. 

6. Save the WebSphere Application Server settings. 

7. Stop the WebSphere Application Server. 

8. Start the WebSphere Portal Server. 

 

Category  Parameter  Recommended 
Set t ing  

How to  Conf igure  in  
the  Admin Console  

Java Virtual 
Machine 

Maximum Heap Size 1 Gb or more Servers > Application 
Servers > 
WebSphere_Portal > 
Process Definition > Java 
Virtual Machine

 Generic JVM Arguments - Xnoclassgc 1 Servers > Application 
Servers > 
WebSphere_Portal > 
Process Definition > Java 
Virtual Machine
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Category  Parameter  Recommended 
Set t ing  

How to  Conf igure  in  
the  Admin Console  

Servlet Caching Enable Servlet Caching Enabled 
(make sure the box 
is checked) 

Servers > Application 
Servers > 
WebSphere_Portal > Web 
Container > Servlet 
Caching

Dynamic Cache 
Service 

Enable Service at Server 
Startup 

Enabled 
(make sure the box 
is checked) 

Servers > Application 
Servers > 
WebSphere_Portal > 
Dynamic Cache Service> 
Startup State

Session 
Management 

Session Timeout 10 minutes Servers > Application 
Servers > 
WebSphere_Portal > Web 
Container > Session 
Management

Thread Pool Maximum Size 70 Servers > Application 
Servers > 
WebSphere_Portal > ORB 
Service > Thread Pool

JDBC Providers Statement Cache Size 500-1000 2 Resources > JDBC 
Providers > 
JDBC_provider > Data 
Sources > data_source

 Max Connections Resources > JDBC 
Providers > 
JDBC_provider > Data 
Sources > data_source > 
Connection Pool

25 or more 3 

 

Note Disables class garbage collection, making class reuse more available, and slightly 
improving performance. 

Note You can monitor the cache size in Tivoli Performance Viewer to see if it's large enough. 

Note Applies only if you migrate from the default Cloudscape database to an Oracle database. 
Otherwise, use the default setting. 

 

Launching and Verifying the WebSphere Portal 

The best way to verify that WebSphere Portal has been installed and is working properly is to 
launch your portal and sign in. 
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To launch WebSphere Portal: 

1. Make sure the Web server and WebSphere Portal server are running. 

2. Open a browser and go to the WebSphere Portal URL: 
http://<hostname>:<port>/<baseURI>/<homepage> 

For example, if you accepted the default values during installation, enter the following URI: 

http://<hostname>:9081/wps/portal 

The portal should load in the browser. 

3. Click Log In. Enter the administrative user ID and password. Click Log In. 

If you have trouble either loading the WebSphere Portal in the browser or logging in as the 
administrator, see the IBM WebSphere Portal InfoCenter for troubleshooting information. 

Configuring the WebSphere Portal for LDAP 

If you install an LDAP server to manage users for the Agile Application Server, you can also use it 
for authentication on the WebSphere Portal. The same LDAP users can then access both systems. 

If the portal server will be integrated with LDAP, install the software as a user that exists within the 
LDAP environment. Note the user ID and password so that you can install WebSphere Fix Packs 
when necessary. 

For more information about setting up LDAP for the WebSphere Portal, see the IBM WebSphere 
Portal InfoCenter. 

Creating Portal Users and User Groups 

On a production server, WebSphere Portal supports authentication using an LDAP accessible 
directory. Ordinarily, you would use the same LDAP server to maintain users for both the Agile 
Application Server and the WebSphere Portal, thereby simplifying authentication for both systems. 
If you install WebSphere Portal for the purposes of portlet development, an LDAP directory is not 
required. In such an installation scenario, the portal administrator must define the users and user 
groups that use Agile Portlet Services. On a development server, users and user groups are stored 
in the WebSphere Portal database. 

The portal administrator can use the Access Control List portlet to control the access rights that 
users and user groups have for all portal resources, such as pages, and portlets. You can assign 
different access rights to each user or user group for each type of resource. Users in a group inherit 
the access rights assigned to the group. 

For more information about WebSphere access control, see the IBM WebSphere Portal InfoCenter. 

To create a portal user: 

1. Select Administration > Access > Users and Groups. 

2. Click the link for All Authenticated Portal Users. 

3. Click New User. 
4. Enter values for User ID, Password, Confirm Password, First Name, and Last Name, which are all 

required fields. For Preferred Language, select English. Optionally, specify the user’s email 
address. Click OK. 
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To create a user group: 

1. Select Administration > Access > Users and Groups. 

2. Click the Root link if it is not already selected. 

3. Click New Group. 

4. Type a name in the Group Name field, and then click Create Group. 

5. In the User Groups list, click the name of the group you just created. Click Add Member. 
6. Select users by checking the Select box to the left of the user name. Click OK. 

To assign access rights to users and user groups: 

Select Administration > Access > User and Group Permissions. See User and Group Permissions 
portlet help for detailed instructions on using the portlet. 

Note If you do not assign access rights to users, they will not be able to view Agile 
portlets and pages. Only the portal administrator will have rights to those 
resources. 

 

Installing Agile Portlet Services 
Based on the license key you used to install Agile PLM 9.2.2.3 and its service packs, Agile Portlet 
Services are automatically installed on the Agile Application Server. All Agile portlets are contained 
in one file, AgilePortletPack2.war. Once you install the file, you must use WebSphere Portal 
Administration to install the portlets on the portal. 

To install Agile Portlet Services on WebSphere Portal Enable 5.1.0.4: 

Install Agile PLM 9.2.2.3. For installation instructions, refer to the separate Agile PLM 
installation guide. 

Agile Portlet Services files are installed into the agile_home\Portlet_51 folder on the Agile 
Application Server. 

1. On the Agile Application Server, open a browser window and go to the WebSphere Portal URL. 
The default URL is: http://<hostname>:9081/wps/portal 

2. Click Log In. Enter the administrative user ID and password. Click Log In. 

3. Select Administration > Portlet Management > Web Modules > Install. 
4. Click the Browse button to select the AgilePortletPack2.war file located in the 

agile_home\Portlet_51\war folder on the Agile Application Server. 

If the Agile Application Server is hosted on BEA WebLogic Server, select the 
AgilePortletPack2.war file located in the agile_home\Portlet_51\war\weblogic folder. 

5. Click Next. 
The page lists the Agile portlets that will be installed from the WAR file you selected. 

6. Click Finish. 

To install Agile Portlet Services on WebSphere Portal Express 6.01: 

1. Install Agile PLM 9.2.2.3. For installation instructions, refer to the separate Agile PLM 
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installation guide. 

Agile Portlet Services files are installed into the agile_home\Portlet_51 folder on the Agile 
Application Server. 

2. On the Agile Application Server, open a browser window and go to the WebSphere Portal URL. 
The default URL is: http://hostname:10038/wps/portal 

3. Click Log In. Enter the administrative user ID and password. Click Log In. 

4. Select Administration > Portlets > Install. 
5. Click the Browse button to select the AgilePortletPack2.war file located in the 

agile_home\Portlet_50\war folder on the Agile Application Server. 

If the Agile Application Server is hosted on BEA WebLogic Server, select the 
AgilePortletPack2.war file located in the agile_home\Portlet_51\war\weblogic folder. 

6. Click Next. 
The page lists the Agile portlets that will be installed from the WAR file you selected. 

7. Click Install. 
 

Setting Agile Portlet Services Application Parameters 
Agile Portlet Services has several application parameters that are crucial to the successful 
operation of all Agile portlets. If any one of the application parameters is configured incorrectly, it 
can cause the portlets to malfunction or fail to connect to the Agile PLM server. 

To set Agile Portlet Services application parameters on WebSphere Portal Enable 5.1.0.4: 

1. After Agile portlets are installed, log into the WebSphere Portal as an administrative user. 

2. Select Administration > Portlet Management > Applications. 

3. Search for “AgilePortlets 2.1”. 

4. Click the  Edit Portlet Application icon. 

5. Specify parameters shown in the table below. 
 The parameter values are read-only. To change a parameter value, do this: 
 Copy the parameter name, and paste it into a text editor (such as Notepad). 
 Click the  Delete Parameter icon to remove the parameter. Click OK to confirm. 
 Click OK to save changes. 
 Click the  Edit Portlet Application icon again. 
 Copy the parameter name from the text editor, and paste it into the New Parameter text box. 
 Enter the new value for this parameter in the New Value text box. 

 Click  to add the new parameter. 

6. When you are finished modifying parameters, click OK. 

To set Agile Portlet Services application parameters on WebSphere Portal Express 6.01: 

1. After Agile portlets are installed, log into the WebSphere Portal as an administrative user. 

2. Select Administration > Portlets > Manage Applications. 

 Page - 11

  

 

http://hostname:10038/wps/portal


Portlet Services Installation and Configuration Guide  
 
 
 

3. In the Web Modules list, select AgilePortletPack2.war. You can search for it if it’s not listed. 

4. In the Portlet Applications Belonging to the Selected Web Module list, select AgilePortlets 2.1 and 
click Modify Parameters. 

5. Specify parameters shown in the table below. 

6. Click Save. Agile portlets are now configured to connect to your Agile server. 

 

Parameter  Descr ipt ion 

VaultSlotName This is the name of the Credential Vault slot. Agile's Single Signon 
Portlet creates a slot with this name in the Credential Vault 
automatically. The default slot name is AgilePLMSlot. 

Note: Generally, you should not modify the value for VaultSlotName. If 
you specify a different slot name, you will need to create all user 
credentials again. 

download.javaPlugin.url Enter the location of the Java plugin to use for client-side browsers. The 
Gantt Chart applet uses this URL to download Java Runtime 
Environment (JRE) version 1.4.2 if the client computer does not have 
the proper version installed. 
Default: http://java.sun.com/j2se/1.4.2/download.html

UnzipFilesOnUpload If you upload a ZIP file to the Agile File Management server, this 
parameter determines whether a checkbox option will appear in the 
portlet to allow you to unzip the file automatically. Enter true (the 
default) or false. 

portletConfiguratorURL Enter the URL for the Portlet Configurator JNLP file. This URL makes it 
possible to launch the Portlet Configurator applet from the Business 
Object portlet configuration page to configure Agile portlets. Otherwise, 
you can configure Agile portlets by editing the XML configuration file. 

Example:http://plm.company.com/configurator/configurator.jnlp

portalAdministratorEmail Enter the email address of the portal administrator. This address is 
used to notify the portal administrator of any errors that occur with Agile 
portlets. 

createMultipleFileFoldersOn-
Upload 

If you upload files to the Agile File Management server, this parameter 
determines whether a checkbox option will appear in the portlet to 
allows you to add the files to one file folder or multiple file folders. Enter 
true (the default) or false. 

help.base.url Enter the base URL for the Web server location where Agile portlets 
access online help files. Each portlet can be configured to access a 
specific help file located relative to this base URL. 

Example:http://portalserver/PortletsHelp
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Parameter  Descr ipt ion 

ppm.weekendDays Enter two comma-delimited integers that represent the days of the 
week that are considered weekends by the Agile Product Portfolio 
Management (PPM) solution. Weekend days are not counted when 
Agile PLM calculates start and end dates based on the number of 
business days estimated for a task. 

Here is the list of integers for the days of the week: 

0=Sunday 

1=Monday 

2=Tuesday 

3=Wednesday 

4=Thursday 

5=Friday 

6=Saturday 

Default: 0,6 

proxy.server.url Enter the URL used to connect to the Agile server. Enter the URL in this 
format: 

Format:<protocol>://<serverName>:<port>/<virtualPath>
where 

 protocol is HTTP or HTTPS. 

 serverName is the name of the Agile PLM server 
computer, not the proxy server. 

 port is the port number used for the specified server. 
Default ports are: 

IBM WebSphere Application Server = 9080 

Oracle Application Server = 7777 

BEA WebLogic Server = 7001 

 virtualPath is the virtual path for your Agile server. The 
virtual path is specified when the Agile system is 
installed. By default, the virtual path is “Agile”. 

Examples:
Oracle Application Server: http://plm.company.com:7777/Agile
BEA WebLogic Server: http://plm.company.com:7001/Agile

 Page - 13

  

 

http://plm.company.com:7777/Agile
http://plm.company.com:7001/Agile


Portlet Services Installation and Configuration Guide  
 
 
 

Parameter  Descr ipt ion 

server.timeout The Agile PLM server session timeout value. Do not confuse this with 
the portal session timeout. The Agile PLM server will timeout after a 
specified number of minutes. The portal administrator can use this 
parameter to align the session timeout from Agile portlets with that of 
the Agile PLM server. 

To specify a timeout value, enter a positive number in minutes. To use 
the same timeout setting as the application server, specify a negative 
value. To never timeout, enter zero (0). 

Default: 60 (minutes) 

 
 

Setting Application Parameters for Copies of Agile Portlets 

When you make a copy of a portlet, such as the Business Object portlet or Advanced Search 
portlet, WebSphere Portal Server also makes a copy of the portlet application, along with its 
application parameters. If you subsequently make a change to the portlet application parameters, 
you must make the same change to every copy of the portlet application. 

Note When you copy a portlet and consequently make a copy of the AgilePortlets application, 
you can rename the new application to identify the portlet it is associated with. 

 

Setting Up the Agile Portlet Configurator 
The Agile Portlet Configurator provides an easy-to-use graphical user interface for configuring the 
Business Object portlets, which has many configuration options. When you install Agile Portlet 
Services, the Agile Portlet Configurator files are installed into the following folder: 

 WebSphere Portal Enable 5.1.0.4: agile_home\Portlet_51\configurator 

 WebSphere Portal Express 6.01: agile_home\Portlet_51\configurator 

Before you can launch the Agile Portlet Configurator applet, you need to add the files to your Web 
server and perform some configuration steps. You can use the Agile Portlet Configurator to 
configure only Agile Business Object and User Profile portlets. It cannot be used to configure other 
portlets. 

To set up the Agile Portlet Configurator: 

1. Configure your Web server so that it handles JNLP files. This is necessary so that Java Web 
Start can successfully download the application classes from the network and install it on your 
computer. For instructions on setting the JNLP MIME type for both IIS and Apache Web 
servers, see “Configuring the JNLP MIME Type” below. 

 

Web Server  Defau l t  docroot  d i rectory  

Internet Information Server (IIS) c:\InetPub\wwwroot 

IBM HTTP Server c:\IBMHttpServer\htdocs 
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Web Server  Defau l t  docroot  d i rectory  

Apache Web Server c:\Apache\htdocs 

 

2. In the <docroot>\configurator folder, open the configurator.jnlp file, and change the codebase 
and href parameters in the jnlp tag to reference the correct locations on your Web server. See 
the text in bold below. After you edit the file, save it. 
<?xml version="1.0" encoding="utf-8"?>

< jnlp spec="1.0+" codebase="http://webserver/configurator" 
href="http://webserver/configurator/configurator.jnlp">

    <information>

        Product CollaborationAgile Portlet Configurator</title>

        <vendor>Agile Software Corporation</vendor>

        <description>Agile Portlet Configurator</description>

        <description kind="tooltip">Agile Portlet 
Configurator</description>

        <!--<icon href="photonpc64.gif"/>-->

        <offline-allowed/>

    </information>

    <security>

        <all-permissions/>

    </security>

    <resources>

        <j2se version="1.3+" max-heap-size="640m"/>

        <jar href="configurator.jar"/>

        <jar href="AgileAPI.jar"/>

        <jar href="crimson.jar"/>

        <jar href="jaxp.jar"/>

        <jar href="xalan.jar"/>

    </resources>

    <application-desc main-class=     
"com.agile.ui.portal.portlets.bizObject.configure.PortletConfiguration
Applet">

       </application-desc>

</jnlp>

3. Set the portletConfiguratorURL parameter for Agile Portlet Services to the same URL you used in 
the previous step. For instructions on how to change the portletConfiguratorURL application 
parameter, see “Setting Agile Portlet Services Application Parameters (on page 11)”. 

4. Test whether the Agile Portlet Configurator is working by opening a browser and typing the 
following URL: 

http://Web Server/configurator/configurator.jnlp 
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The Portlet Configurator login dialog box appears. 

Note If the Portlet Configurator doesn’t load successfully, make sure the URLs 
specified in the configurator.jnlp file and the portletConfiguratorURL parameter 
match one another and are correct. Also, make sure Java Runtime 
Environment (JRE) 1.4.2 or later is installed on the client machine. For more 
troubleshooting information about the Portlet Configurator, see  
“Troubleshooting”. 

5. To log in, enter a valid Agile PLM user name and password. For the Server URL, type the 
same URL used for the serverURL application parameter (for example, 
http://plm.company.com:7777/Agile). Click OK. 

The Portlet Configurator window appears. 

Configuring the JNLP MIME Type 
A JNLP file is an XML document that describes a Java application to be launched by Java Web 
Start. To successfully download and install applications using Java Web Start, you must configure 
the JNLP MIME type for your server. 

To configure the JNLP MIME type on Windows: 

1. Choose Start > All Programs > Administrative Tools > Internet Information Services (IIS) Manager. 
The Internet Information Services (IIS) Manager window appears. 

2. Expand the folder for Internet Information Services > servername.   

3. Select the Web Sites > Default Web Site folder, right-click, and choose Properties from the shortcut 
menu. 

The Default Web Site Properties dialog box appears. 

4. Click the HTTP Headers tab. 

5. Click the MIME Types button. 

The MIME Types dialog box appears. 

6. Click the New button. 

7. In the Extension field, type jnlp. In the MIME Type field, type application/x-java-jnlp-file. Click OK. 

8. The new file type appears in the Registered MIME Types box. Click OK to close the MIME 
Types dialog box. 

9. Click OK to close the Default Web Site Properties dialog box. 

10. Restart IIS. 

To configure the MIME type on Solaris: 

1. Locate the mime.types file in the conf directory of the Apache Web server. 

2. Add the following line to the mime.types file: 

application/x-java-jnlp-file       JNLP
3. Restart the Apache Web server. 
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Upgrading Agile Portlet Services to Agile PLM 9.2.2.3 
To upgrade an existing installation of Agile Portlet Services to 9.2.2.3, follow these steps: 

1. Upgrade your Agile PLM application server and database to Agile PLM 9.2.2.3. 

2. (Optional) Upgrade from WebSphere Portal Express 5.022 to WebSphere Portal Enable 5.1.0.2. 

3. Log into the WebSphere Portal as an administrator and uninstall any existing Agile PLM 9.0 or 
9.1 portlets. 

4. Install new Agile PLM 9.2.2.3 portlets. For instructions, see Installing Agile Portlet Services (on 
page 10). 

5. Set application parameters for Agile Portlet Services. See Setting Agile Portlet Services 
Application Parameters (on page 11) for more details. 

6. Update Agile PLM portlet pages for your portal. 

7. If you configured the Business Object Portlet for your portal, you can update XML configuration 
files to the Agile PLM 9.2.2.3 format using the XML Upgrade Tool. 

 

Using the XML Upgrade Tool 
The XML Upgrade Tool is a simple command-line Java utility for upgrading Business Object Portlet 
XML configuration files from earlier versions to 9.2.2.3. The main difference in the Business Object 
Portlet configuration is that it now supports configurations for multiple classes. You can use the 
XML Upgrade Tool to convert an old XML configuration file to the new format. You can also 
concatenate multiple XML configuration files together into one new XML file. 

To update an existing Business Object Portlet XML configuration file to Agile 9.2.2.3 format: 

1. On the computer where Agile Portlet Services are installed, open a command prompt window. 

2. Change to the XML Upgrade Tool folder: 
 WebSphere Portal Enable 5.1.0.4: agile_home\Portlet_51\xmlupgradetool 
 WebSphere Portal Express 6.01: agile_home\Portlet_51\xmlupgradetool 

3. Run the following command: 
java -classpath ./XMLUpgradeTool.jar;./jdom.jar 
com.agile.ui.portal.portlets.bizObject.configure.tools.XMLU
pgradeTool file1 [ file2...filen] 

At least one input file argument is required. Files must use fully qualified paths, such as 
c:\temp\bop1.xml. Separate multiple files with spaces. If you specify multiple files, the XML Upgrade 
Tool combines them into one output file. 

The output file is created in the same directory where you ran the XML Upgrade Tool. The name of 
the output file is the concatentation of the input filenames plus “_<release version>.xml”.  

The following example shows how to combine two files named bop1.xml and bop2.xml into a new 
output file named bop1.xml_bop2.xml_9222.xml. 

java -classpath ./XMLUpgradeTool.jar;./jdom.jar 
com.agile.ui.portal.portlets.bizObject.configure.tools.XMLU
pgradeTool c:\temp\bop1.xml c:\temp\bop2.xml 

After you create the new Agile 9.2.2.3 XML configuration file, you can copy it into the Portlet 
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Configurator to configure an Agile 9.2.2.3 Business Object Portlet. 

Updating Agile Portlet Services 
If you receive an updated Agile Portlet Services WAR file and you have already installed Agile 
portlets on the WebSphere Portal, you do not need to reinstall them. Instead, follow these steps to 
update Agile portlets. 

To update the Agile Portlet Services WAR file on WebSphere Portal 5.1.0.4: 

1. Open a browser window and go to the WebSphere Portal URL. The default URL is 
http://<hostname>:9081/wps/portal. 

2. Click Log In. Enter the administrative user ID and password. Click Log In. 

3. Select Administration > Portlet Management > Web Modules. 

4. Find AgilePortletPack2.war, and then click the  Update Web Module icon. 

5. Click the Browse button to select the updated AgilePortletPack2.war file. Click Next. 
6. The Manage Web Modules page lists the portlets that will be updated from the WAR file you 

selected. Click Finish to begin updating them. 

7. After installation is finished, stop the WebSphere Portal and clear the Agile SDK cache on the 
portal server. See the next section. 

To update the Agile Portlet Services WAR file on WebSphere Portal 6.01: 

1. Open a browser window and go to the WebSphere Portal URL. The default URL is 
http://<hostname>:10038/wps/portal. 

2. Click Log In. Enter the administrative user ID and password. Click Log In. 

3. Select Administration > Portlets > Manage Applications. 

4. In the Web Modules list, select AgilePortletPack2.war and then click Update. 

5. Click the Browse button to select the updated AgilePortletPack2.war file. Click Next. 
6. The Manage Portlet Applications tab lists the portlets that will be updated from the WAR file 

you selected. Click Install. 
7. After installation is finished, stop the WebSphere Portal and clear the Agile SDK cache on the 

portal server. 
 

Clearing the Agile SDK Cache 
Whenever you update the Agile Portlet Services WAR file by installing a new version, you must 
clear the Agile SDK cache on the WebSphere Portal computer. When you delete the Agile SDK 
cache, it forces Agile portlets to use the network class loader to download the latest classes, which 
allow Agile portlets to connect to the updated Agile 9.2.2 server. 

To clear the Agile SDK cache: 

1. Stop the WebSphere Portal. 

2. Open a Command Prompt window. 
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3. Change to the %temp% directory: 

cd %temp%
4. Delete the Agile SDK cache subdirectory: 

del AgileSDK.cache
5. You are prompted “Are you sure?” Enter Y for Yes. 

6. Restart the WebSphere Portal. 
 

Setting Agile Portlet Parameters 
Before placing Agile portlets on a page to define the layout of your portal, you should set the 
parameters for each portlet you intend to use. 

To modify portlet parameters for WebSphere Portal 5.1.0.2: 

 Select Administration > Portlet Management > Portlets. 

1. Click the  Configure Portlet icon for an Agile portlet. The Manage Portlets page appears. 

2. For the parameter you want to change, click the  Edit Parameter icon. 

3. In the Value field, enter a new value. 

4. Click OK. 

To modify portlet parameters for WebSphere Portal 5.022: 

1. Select Administration > Portlets > Manage Portlets. 

2. Select a portlet, and click Modify Parameters. The configuration parameters window opens. 

3. Edit the parameter values. 

4. Click Save. 

Note Several portlet parameters are designed to be modified only from the portal 
page when the portlet is in Configure mode. To enter configure mode, go to the 
portal page and click the portlet’s  wrench icon. Other users can personalize 
the portlet by clicking the  pencil icon in the portlet’s title bar. 
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Parameter  Descr ipt ion Agi le  Port le ts  

clearPortletContentsIfMes If set to true, this parameter clears the 
portlet of its contents if a message 
received from another portlet (such as 
a Search portlet) is not supported. 

Default: false

Business  
Object 

customTitle An optional custom title for the portlet 
that appears in the portlet’s title bar. 

All 

disableTableStatusFlags If set to true, the portlet disables 
status flag attributes such as Has 
Attachments and Has Action Items. 

Default: false (status flag attributes 
are enabled) 

Business  
Object 

Saved  
Search 

Search  
Results 

help.relativePath The relative path of this portlet’s help 
file. The relative path is combined with 
the help.base.url value to create the 
complete URL for the help file. 

All 

help.url The complete URL for an online help 
file for this portlet. This URL overrides 
the URL specified by the 
help.relative.path portlet parameter 
and the help.base.url application 
parameter. 

All 

mTTConfiguredViews Specify the comma-delimited series of 
selected views for the portlet. 

Default: 1,0,2 

0 = My Workflow Routings 

1 = My Action Items 

2 = My Activities 

My Things  
To Do 

mTTPossibleViews Specify the comma-delimited series of 
possible views for the portlet. 

Default: 1,0,2 

0 = My Workflow Routings 

1 = My Action Items 

2 = My Activities 

My Things  
To Do 
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notfConfiguredViews Specify the comma-delimited series of 
selected views for the portlet. 

Default: 0,1 

0 = My Notifications 

1 = My Requests 

My Notifications 
and Requests 

notfPossibleViews Specify the comma-delimited series of 
possible views for the portlet. 

Default: 0,1 

0 = My Notifications 

1 = My Requests 

My Notifications  
and Requests 

objectType The currently selected Agile object 
type used in the Advanced Search 
portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

Advanced  
Search 

pageid_Report_cstRptCfgEnabled Equivalent to the Enable Customer 
External Reports checkbox in the 
portlet’s Configure mode. A separate 
cstRptCfgEnabled parameter is 
provided for each portal page on 
which the Report Folder Browser 
portlet has been added. Possible 
values for the parameter are 0 (false) 
and 1 (true). 

Default: 0 

Report  
Folder  
Browser 

pageid_Report_rootFolderId Select a report folder by specifying its 
numeric ID. 

To find the ID number of a report 
folder, move the mouse over a folder 
in the Report Folder Browser portlet. 
The ID number appears in the 
browser’s status bar. 

A separate rootFolderId parameter is 
provided for each portal page on 
which the Report Folder Browser 
portlet has been added. 

The portlet’s Configure mode offers 
a much easier graphical user 
interface for selecting a report 
folder.

Report  
Folder  
Browser 
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queryCriteria Defines the search criteria used for the 
Advanced Search portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

 

quickLinksXml Defines the XML configuration for the 
Quick Links portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

Advanced  
Search 

quickSearchInfoText Sample query information to help 
users enter a value to search for in the 
Quick Search portlet. This sample 
query text appears when you click the 
Show Sample Queries link in the 
portlet. 

Quick  
Links 

ReportServerSettingKeys Aggregates the keys that have been 
set for all portal pages on which the 
Report Folder Browser has been 
added. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

Quick  
Search 

savedSearchId The ID number of a saved search. The 
results of the search will appear in the 
Quick Navigation portlet. 

Not Supported. This parameter is 
obsolete and does not affect the 
Quick Navigation portlet.

Report  
Folder  
Browser 

scrollBarHeightLimit The height of portlet data. If portlet 
data exceeds the specified height, a 
vertical scroll bar appears. 

This parameter does not set the height 
of the portlet. To do that, you must edit 
the page layout. 

Quick  
Navigation 

scrollBarWidthLimit The width of portlet data. If portlet data 
exceeds the specified width, a 
horizontal scroll bar appears. 

This parameter does not set the width 
of the portlet. To do that, you must edit 
the page layout. 

Quick  
Navigation 

Report  
Folder  
Browser 

Search  
Folder  
Browser 
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searchableAttributes The list of available attributes that can 
be used in search criteria. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

Quick  
Navigation 

Search Folder 
Browser 

searchConfigurationXML Defines the XML configuration for the 
Advanced Search portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

Advanced  
Search 

Search_savedSearchId Select a saved search by specifying its 
numeric ID. 

To find the ID number for a saved 
search, move the mouse over a saved 
search in the Search Folder Browser 
portlet. The ID number appears in the 
browser’s status bar. 

The portlet’s Configure mode offers 
a much easier graphical user 
interface for selecting a saved 
search.

Advanced  
Search 

searchDisplayAttributes The list of available attributes that can 
be used in search results. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

Saved  
Search 

simpleSearchInfoText A brief message that provides 
information about a Simple Search to 
help users of this portlet. 

Not Supported. Simple Search is no 
longer an option of the Advanced 
Search portlet.

Advanced  
Search 

supportedSearchTypes Specify the Agile object types that can 
be searched for in the Advanced 
Search portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it.

Advanced  
Search 
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tableHeight The height of the table that appears in 
the portlet. If the table exceeds the 
specified height, a vertical scroll bar 
appears. 

To enable tableHeight and tableWidth 
parameters, both must be set to 
nonzero values. 

Default: 0 (disabled) 

This parameter does not set the height 
of the portlet. To do that, you must edit 
the page layout. 

Advanced  
Search 

tableWidth The width of the table that appears in 
the portlet. If the table exceeds the 
specified width, a horizontal scroll bar 
appears. 

To enable tableHeight and tableWidth 
parameters, both must be set to 
nonzero values. 

Default: 0 (disabled) 

This parameter does not set the width 
of the portlet. To do that, you must edit 
the page layout. 

Business  
Object 

Saved  
Search 

Search  
Results 

  Business  
Object 

Saved  
Search 

Search  
Results 

 
 

Creating Portal Pages 
The WebSphere Portal has a hierarchical structure of nodes. Each node is an element in the portal 
navigation tree. There are three types of nodes: 

 page — Displays content in the form of portlets. 

 label — Container for other nodes. Labels are used to group nodes in navigation. 

 URL — An addressable resource, such as external Web pages or pages within the portal site. 

The topmost node in the portal navigation tree is the content root. After you install WebSphere 
Portal, the following nodes appear under the content root: 
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 My Portal — a label containing portlets for general use. This is the default page displayed after 
login. 

 Administration — a label used containing pages with portlets used to administer the WebSphere 
Portal. 

 Page Customizer — a label with child pages used to manage page content and layout. 

 Page Properties — a page used to edit the properties of portal page. 

 Organize Favorites — a page containing the Organize Favorites portlet, which lets portal users 
organize their favorite labels and URLs. You can access the Organize Favorites page using the 
My Favorites list in the banner. 

Users without administrative privileges can access only the My Portal node. Administrators can use 
links in the banner to switch between Administration and My Portal. 

A page displays content, or portlet applications. Each page can contain one or more portlets. To 
view a page, first select the place. Once the place is selected, you can click a page within the place. 

To create an Agile label in My Portal: 

1. Select Administration > Portal User Interface > Manage Pages. 

2. Click the My Portal label. 

3. Click New Label. 
4. Type Agile and click OK. 

5. The Properties page appears. Click OK. 

To add a page to the Agile label: 

1. Select Administration > Portal User Interface > Manage Pages. 

2. Select Content Root > My Portal > Agile. 

3. Click New Page. 

4. Type the name of the page and click OK. For example, type Programs to create a page showing 
Agile programs. 

5. The Properties page appears. Click OK. 

Note Portal pages can be imported from a portal configuration file using IBM’s XML 
Access tool. For more information, see “Exporting and Importing Portal 
Configurations using the XML Configuration Interface (on page 46)”. 

 

Editing the Layout of a Page 

WebSphere Portal lets you control the layout of portal pages, select and arrange portlets on a page, 
and edit portlets that require configuration. 

Pages can contain columns, rows, and portlets. You can fill the columns and rows with portlets or 
other columns and rows. You can also create nested pages. 

To create a page with Agile portlets, you must select a logical group of portlets to display Agile 
content. A page you create might include: 

 the Single Signon portlet, which connects a user to the Agile PLM server. Only one Single 
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Signon portlet is needed for your portal. The same connection is used for all Agile portlets on 
multiple pages. 

 a Search portlet to locate Agile PLM content. Quick Search and Advanced Search are 
examples of Search portlets. 

 a Content portlet, such as a copy of the Business Object portlet, to display data for a selected 
object. 

To edit the layout of a portal page: 

1. Select Administration > Portal User Interface > Manage Pages. 

2. Select a portal page to edit. 

3. Click the  Edit Page Layout icon. 

Some of the options you can select on the page include: 

 Layout template: Select from several preconfigured page layouts. 

 Add portlets: Select portlets to add to the page. 

 Show layout tools: Shows advanced layout tools for creating and editing page containers. This 
option overrides the preconfigured layout templates. For example, you can set the column 
width. 

The following figure shows an example of a two-column layout for a page that includes the Single 
Signon, Quick Search, Search Results, and Item (Business Object) portlets. 
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Administering Pages 

The portal administrator can permit specified users to change the layout of a page. If you have 
authority to change a page, you can use Administration > Manage Pages to modify the layout. For each 
page, you can click the  Set Page Permission icon to specify the permissions that users have to edit 
the page. 

For more detailed information about creating and modifying places and pages, see the “Managing 
Pages, Layout, and Content” topic in the IBM WebSphere Portal InfoCenter. 

Setting Resource Permissions 

In addition to creating users and user groups, the portal administrator can specify permissions for all 
types of portal resources, including pages and individual portlets. This allows the portal 
administrator to set the level of personalization for each page or each portlet. 

To access Resource Permissions for your portal, use one of these methods: 

 Choose Administration > Access > Resource Permissions. 

 Click Assign permissions in the page banner. 

 Click the Set Permission icon in the Manage Pages portlet. 

For more detailed information about setting resource permissions, see the “Authorization” topic in 
the IBM WebSphere Portal InfoCenter. 

Using Custom Themes and Skins 

Portal pages also have themes and skins, which are usually created by the Web designer of the 
portal. Themes control the look and feel of the portal, including colors and fonts. For each theme, 
there are one or more skins that define the style of the area surrounding individual portlets.  

To set the default theme and skin for the portal: 

Select Administration > Portal User Interface > Themes and Skins. 

If you create custom themes or skins, you can test them on a development system. After the 
themes and skins are fully developed and tested, you must update and redeploy the WebSphere 
Portal EAR file with the new themes and skins. 

For more information about custom themes and skins, see the IBM WebSphere Portal InfoCenter. 

Agile PLM Administration Settings Related to Portlets 
After Agile Portlet Services are successfully installed and configured, the Agile PLM administrator 
must configure the application server to interface with the portal properly. The administrator must 
perform the following tasks to ensure that Agile PLM users can launch the portal Web site from 
email notifications they receive. 

The Preferred Client user preference specifies which Agile PLM client to launch from email 
notifications. The available choices are Java Client, Web Client, or Portal Client. The Preferred 
Portal URL user preference specifies which portal URL to go to if the user selected Portal Client as 
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his preferred client. 

For more information about Agile PLM administration, see the Agile PLM Administrator Guide. 

To add a portal URL to the Agile PLM server: 

1. Log into the Agile Java Client as an administrator. 

2. Choose Admin > Server Settings > Locations > Portals. 

3. Click the New toolbar button to add a portal URL. 

4. In the Name field, type the name of the portal. 

5. In the Portal field, type the portal URL. 

6. In the Enabled list, select Yes. 

7. Click OK. 

To configure the Agile PLM portal as your preferred Agile PLM client for email notifications: 

1. Log into the Agile Web Client. 

2. Choose Admin > User Settings > Users. 

3. Choose Tools > My Settings. 

4. Click User Profile. 

5. Click the Preferences tab. 

6. Click Edit. 
7. Click the Preferred Client list and select Portal Client. 

8. Click the Preferred Portal URL list and select a portal. 

9. Click Save. 

Note If the Preferred Portal URL list reads “No Privilege,” make sure the Modify 
Users privilege for Agile PLM applies to the “users.Preferences.Preferred 
Portal URL” attribute. 
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Configuring Agile Portlets 

This chapter includes the following: 

 About Portlet Configuration.................................................................................................................................. 29 
 Portlet Modes....................................................................................................................................................... 30 
 Configuring the Advanced Search Portlet............................................................................................................ 30 
 Configuring a Quick Links Portlet ........................................................................................................................ 31 
 Configuring the Report Folder Browser Portlet.................................................................................................... 32 
 Using the Portlet Configurator ............................................................................................................................. 33 
 Messaging Between Portlets ............................................................................................................................... 45 
 Exporting and Importing Portal Configurations using the XML Configuration Interface....................................... 46 
 Using Process Extensions from within Portlets ................................................................................................... 47 
 Creating Custom Help for Agile Portlets .............................................................................................................. 51 

 
 

About Portlet Configuration 
This section describes how to configure Agile portlets. For most portlets, configuration is simple and 
requires selecting just a few options. The Business Object and User Profile portlets, however, are 
more complicated and have many more options for content and layout. You can configure those 
portlets by editing the XML configuration or using the Portlet Confurator. 

Once an Agile portlet is placed on a page, it can be used by people connecting to the portal. 
However, the following Agile portlets must be configured before they can be used: 

 Advanced Search 

 Business Object 

 Quick Links 

 Saved Search 

 Search Folder Browser 

 User Profile 

To configure a portlet from the page layout: 

1. Select Administration > Portal User Interface > Manage Pages. 

2. Select a portal page that uses Agile portlets. 

3. Click the  Edit Page Layout icon. 

4. Select an Agile portlet, such as one based on the Business Object portlet, and click the  Edit 
Portlet icon. 
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To configure a portlet from a po tal page: r

1. Select a portal page. 

2. Click the Configure icon  (a wrench) for a portlet. 

 help window with information about the portlet. Although Agile Portlet Services 

  portlet. Portlets that support Edit mode have 
a 

 

Portlet Modes 
Each portlet has up to four possible display modes: 

 View — Shows the portlet’s normal user interface. 

Help — Shows a 
does not include online help, you can create your own custom online help for each Agile portlet. 

Edit — Shows a page that lets users personalize a
 pencil icon. 

ure a portlet. Portlets that  Configure — Shows a page that allows portal administrators to config
support Configure mode have a   wrench icon. 

 

Configuring the Advanced Search Portlet 
The Advanced Search portlet has a graphical user interface for specifying its configuration, but it is 

partly because it also requires that you are familiar with the 

1. 

more complex than other Agile portlets, 
Agile API query language. This section steps you through the somewhat t cky process of 
configuring an advanced search. 

ri

To configure the Advanced Search portlet: 

Select a portal page with the Advanced Search portlet, and click the  wrench icon to enter 
Configure mode. 

In the Select Class To Search drop-down list, select the cla2. ss or subclass to search for. 

set of search and display attributes can 
d 

4. tes to include in the search parameters, and then click 

If you select a base class (such as Items), a different 
be configured for each class. If you select a class (such as Parts), a different set o search an
display attributes can be configured for each subclass. 

f 

3. In the Define Search For drop-down list, select a class. 

Select one or more attribu  to move 

5.  in the search results, and then click 

them into the Selected Attributes box. 

Select attributes to display  to move them into the 

inactive list values from searches, make sure the Exclude inactive values for List 

Update to update the search. 

Selected Attributes box. 

6. To exclude 
Attributes box is checked. 

7. Click 

8. Click Save. 

9. Click Return to return to the portlet. 
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Configuring a Quick Links Portlet 
The Quick Links portlet lets you set up a portlet with links to portal pages and external Web sites, 
inclu ther Web applications. The p  XML Configuration w nfigure the 
links. 

The XML configuration for a Quick Links portlet has the following ta

s 

ding o ortlet uses the indow to co

gs: 

Tag Descr ipt ion Example  

Product Collaboration Portlet header ionExternal 
nks</title>

Product Collaborat
Quick Li

<links> Container for links. <links> 

<!--links go here--> 

</links> 

<link  
  name=name 
  openInNewWindow=boolea
n 
>

nNewWindow parameter 
should be set to false (the default). If you 
are referencing an external URL, the 
openInNewWindow parameter should 
be set to true. 

link name="ViewMyPrograms" 
lse">

link name="Yahoo" 
penInNewWindow="true"></l

Link tag. If you are referencing a portal 
URL, the openI

<
openInNewWindow="fa

</link>
 

<
o
ink>
 

 

<label> Label or description of the link. <label>Yahoo</label>

<href> A Web location (URL) <href>http://www.agile.com</
href>

Here is an exam Ls: 

<?xml version=

m Quick Links...</title> 

e="CreateProgram"> 
  <label>View New Program Creation</label> 
  <href>/wps/myportal/createprogram</href> 
 </link> 

ple of a Quick Links XML configuration file with links to several portal UR

"1.0" encoding="UTF-8"?> 
<links> 
 Product CollaborationProgra
 <link name="ViewMyPrograms"> 
  <label>View My Programs</label> 
  <href>/wps/myportal/viewmyprograms</href> 
 </link> 
 <link name="UpdateTasks"> 
  <label>View My Tasks</label> 

wps/myportal/updatemytasks</href>   <href>/
 </link> 
 <link name="UpdateActionItems"> 
  <label>View My Action Items</label> 
  <href>/
 </link> 

wps/myportal/myactionitems</href> 

 <link nam
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</links> 

In the previous example, “viewmyprograms,” “updatemytasks,” Note 
“myactionitems,” and “createprogram” are names that have been mapped 
internally to portal URLs. For information on how to use URL mapping on your 
portal, see “Setting Up Quick Links to Portal Pages (on page 32)” below. 

Here is another example of a Quick Links XML configuration file, this time with links to several 
external URLs: 

sion="1.0" encoding="UTF-8"?> 

.</title> 
"true"> 

tp://www.agile.com</href> 

NewWindow="true"> 

tp://www.yahoo.com</href> 

InNewWindow="true"> 

tp://www.google.com</href> 

NewWindow="true"> 

tp://www.cnn.com</href> 

and a portal page. To create a URL mapping, select Administration > Portal 
Settings > U

Important The URL mapping must be all lower case. 

<?xml ver
<links> 
 Product CollaborationHandy Web Links..
 <link name="Agile" openInNewWindow=
  <label>Agile Software</label> 
  <href>ht
 </link> 
 <link name="Yahoo" openIn
  <label>Yahoo</label> 
  <href>ht
 </link> 
 <link name="Google" open
  <label>Google</label> 
  <href>ht
 </link> 
 <link name="CNN" openIn
  <label>CNN</label> 
  <href>ht
 </link> 
</links> 

Setting Up Quick Links to Portal Pages 

To set up Quick Links to portal pages, you must first create a URL mapping. URL mapping is a 
feature of WebSphere Portal Server that allows portal administrators to define simple, easy-to-
remember URLs and map them to portal pages. The URL mapping creates a relationship on the 
portal between a name 

RL Mapping. 

For more information on how to use URL mapping, see the IBM WebSphere Portal InfoCenter (see 
"IBM WebSphere Portal Server" on page 3). 

ct a folder, the portlet allows 
users to navigate to any reports in that folder and any subfolders. 

Configuring the Report Folder Browser Portlet 
The Report Folder Browser portlet lets you generate reports from one of the Report folders. You 
can configure the portlet to select a particular folder. Once you sele

To configure a Report Folder Browser portlet from a portal page: 

1. Select a portal page that has the Report Folder Browser portlet. 

2. Click the Configure icon  (a wrench) for the Report Folder Browser portlet. 
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3. 

Note  topmost folder that users can navigate to when they 

Select a report folder from the Report Tree. 

This folder becomes the
personalize the portlet. 

4.  launched from the portlet, make sure the Enable 
ed. 

6. Click Return to return to the portal page. 

Using the Portlet Configurator 

, you 
r, if the XML seems too complicated, use the 

To enable customer external reports to be
Customer External Reports box is check

5. Click Save to save the configuration. 

 

For Business Object or User Profile portlets, when you configure the portlet an XML Configuration 
window appears. If you’re familiar with XML and XSL (extensible stylesheet language for XML)
may find it easy to edit the XML directly. Howeve
Portlet Configurator to modify the configuration. 
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Note Configuration of the Business Object portlet should be done only by the portal 
administrator. Consequently, the portal administrator should set resource 
permissions so that ordinary users do not have permission to personalize the 
Business Object portlet. For more information about resource permissions, see 
“Setting Resource Permissions (on page 27)”. 

The Portlet Configurator is a Java application that lets you configure Business Object and User 
Profile portlets using a graphical user interface. Other portlets have simple configuration options, so 
the Portlet Configurator isn’t needed for them. 

The Portlet Configurator connects to the Agile PLM server to read business object classes, 
attributes, tables and actions. After you specify general portlet properties, the content to use 
(attribute groups, tables, and actions), and the layout, you can copy the XML configuration data 
from the Portlet Configurator to the portlet’s XML Configuration window. 

Roles and Privileges Needed to Use Agile Portlet Configuratior 

The Agile Portlet Configurator requires read-access to metadata tables for all Agile PLM classes 
and subclasses to configure Business Object portlets. Therefore, you should have Administrator 
privileges to use it. If you do not have Administrator privileges, see your Agile PLM administrator. 

Launching the Agile Portlet Configurator 

When you connect to the Agile Portlet Configurator Web site, it uses Java WebStart technology to 
deploy the application to your computer. After that, you can launch the Portlet Configurator from 
your computer’s desktop. 

You can also launch the Portlet Configurator from the XML Configurator window of a Business 
Object or User Profile portlet. 

To launch the Portlet Configurator from a portlet: 

1. Select Administration > Portal User Interface > Manage Pages. 

2. Select a portal page that uses Agile portlets. 

3. Click the  Edit Page Layout icon. 

4. Select an Agile portlet, such as one based on the Business Object portlet, and click the  Edit 
Portlet icon. 

5. Instead of editing the XML configuration file for the portlet, click the Launch Configurator link. The 
Portlet Configurator login dialog box appears. After you log in, the Portlet Configurator appears 
in its own window. 

 

Portlet Configurator Toolbar 

The Portlet Configurator has the following toolbar buttons: 
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Button  Command 
Equiva lent  

Descr ipt ion 

File > New Clears any current configuration to create a new configuration. If the 
previous configuration was not saved, you will be prompted whether to 
save it. 

 

File > Open Opens an existing XML configuration file.  

File > Save Saves the current configuration to an XML file. 
 

Edit > Copy XML Copies the XML from the current configuration to the user’s Clipboard. 
 

Edit > Paste XML Pastes XML from the Clipboard to the current configuration. If there is a 
current configuration, you will be prompted whether to overwrite it. 

 
 

Portlet Configurator Tabs 

The Portlet Configurator has three tabs: 

 Classes – Lets you select the classes and subclasses for the portlet, as well as specify the 
portlet title 

 Configure – Lets you define the content and layout of the Business Object portlet. 

 XML – Lets you view or edit the XML for the portlet configuration. 
 

Portlet Configurator Navigation 

The Configure tab of the Portlet Configurator has a navigation pane on the left side of the window 
that lets you quickly switch between the different panes. To switch to a different pane, just click its 
name in the navigation pane. 
 

Using Portlet Configurator to Modify a Configuration 

If a Business Object portlet has already been configured, you may want to modify the existing 
configuration rather starting over with a new configuration. Use the Copy and Paste buttons to edit 
the existing configuration in the Portlet Configurator. 

To modify an existing portlet configuration: 

1. Select a portal page. 

2. Click the Configure icon  (a wrench) for a Business Object or a User Profile portlet that has 
already been configured. The XML Configuration window appears. 

Note If the portlet has not been configured yet, the XML Configuration window is 
empty. If the portlet has been configured, click Copy to copy the configuration to 
the clipboard. 

3. Click Launch Configurator to start the Portlet Configurator. 

4. In the Login dialog box, enter your username, password, and Agile PLM server URL. Click OK. 
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5. Click  Paste. 

6. Click the Configure tab. 

7. Specify the Content and Layout of the portlet. 

8. Click  Copy. 

Note Optionally, you can click  Save to save the portlet configuration to an XML 
file so that you can open it later. 

9. Switch to the portlet’s XML Configuration window. 

10. Click Paste. 

11. Click Save. 

12. Click Return to return to the portal page. 
 

Using the Classes Tab 

For each Business Object portlet, you must specify the classes and subclasses supported by the 
portlet. You can also specify a title for the portlet. To set portlet classes and its title, click the Classes 
tab (by default, the first tab selected). The following options appear: 

 Portlet Title — The title that appears within the skin of the portlet window. It should identify the 
type of business object that appears within the portlet. 

 Object Class — The Agile PLM class used by the portlet. After you select a class, click Add to 
add it to the Defined Class Views list. 

The Business Object portlet supports the following Agile PLM classes: 

 Changes 

 File Folders 

 Items 

let Configurator allows you to configure the Users class to support the 

Note 

 Manufacturer Parts 

 Manufacturers 

 Programs 

 Reports 

 User Groups 

Additionally, the Port
User Profile portlet. 

The actual base classes supported by your Agile PLM system depend on the 
Agile PLM solutions your company has purchased. However, only the above 
classes have been certified to be used with Agile portlets. 

  selected object class, this list shows the available Available Subclasses – Based on the
subclasses that can be selected. 
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 es are 

. 

re shows a portlet that has been configured to support all the subclasses of the 

Selected Subclasses – Subclasses selected for this portlet. By default, all subclass
selected. However, you can disable a subclass for the portlet by deselecting it. 

 Defined Class Views – Lists the object classes that have been added to the portlet configuration

The following figu
Changes class. 

 

Using the Configure Tab 

u can specify the content and layout, you must select a class in the Configure for 

 

The Configure tab is where you specify the content and layout of the portlet for a particular base 
class. Before yo
Base Class list. 

 

 Sets how Page One, Page Two, and Page Three attributes are grouped 

s that appear in each table. 

Sets the action buttons that appear in the portlet. 

There are three types of content you can specify for the portlet: 

Attribute Groups — 
within the portlet. 

 Tables — Sets which tables are used in the portlet, and the column

 Action Groups — 
 

Attribute Groups 

Business object classes and subclasses can have many attributes visible on Page One, Page Two, 
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and Page Three. Therefore, to provide a more usable portlet interface you should assign the 
attributes to meaningful groups. The same attribute can appear in multiple groups, if you prefer. To 

t ane of the Portlet Configurator. The 

or 

y default, the group is fully expanded. 

to display the attributes. Select one 

 te ubset of attributes. Available filters are: 

e 

c

 Available A e currently selected filter. 

ed in the 

se attribute groups, click Attribute Groups in the navigation p
following options appear: 

 Attribute Group Name – Name of the group of attributes. 

 Display Name as Heading – Check this box to display the attribute group name as a heading f
that area of the portlet. 

 Collapse Group by Default – Check this box to collapse the attribute group and show only its 
name. B

 Number of Columns – Specifies the number of columns used 
or two. 

Fil r – Displays a s
 All Page One 
 All Page Two 
 All Page Thre
 <Subclass> (includes all Page One, Page Two, and Page Three attributes for a particular 

sub lass) 

ttributes – Displays the list of available attributes based on th

Note Although the User Group > Assignment > Date Group Table attribute is list
Available Attributes list, it’s not supported by Agile portlets. 

 Selected Attributes – Select attribute to add to the attribute group. 

 Add button – Adds the new attribute group. 

 Update button – Updates the selected attribute group with the current settings. 

 Delete (X) button) – Deletes the selected attribute group. 
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The following figure shows an attribute group that has been defined for Page One attributes. 

 
 

Tables 

Based on a portlet’s object class, there are several tables you can choose to display in the portlet. 
You can specify which tables should appear in the portlet and the columns or fields that appear in 
each table. To configure the content of tables, click Tables in the navigation pane of the Portlet 
Configurator. The following options appear: 

 Choose Table – Select a table from the list. 

 Display Name – Name of the table. 

 Display Name as Heading – Check this box to display the table name as a heading for that area of 
the portlet. 

 Collapse by Default – Check this box to collapse the table and show only its name. By default, the 
table is fully expanded. 

 Available Columns – Displays the list of available columns based for the selected table. 

 Selected Columns – Selects columns to add to the table configuration. Columns appear in the 
portlet in the order they are listed. 

Note To change the order of columns, select a column and click  or  to move 
it up or down. 

 the current settings. 

 Delete (X) button) – Deletes the selected table configuration. 

 Add button – Adds the new table configuration. 

 Update button – Updates the selected table configuration with

 Page - 39

  

 



Portlet Services Installation and Configuration Guide  
 
 
 

The following figure shows how the Change Orders.Affected Items table has been configured. 

 
 

Action Groups 

When you configure a Business Object portlet, you can enable an Actions toolbar with buttons and 
menu commands for object-level actions. These actions apply to the entire object. You can select 
which actions are available in the portlet and organize them into functional groups. 

The actions that you can select for the portlet depend on the object class. They can include: 

 Common actions (Bookmark, Delete, New, Print, SaveAs, Send, Subscribe, Edit, 
CopyToClipboard) 

 Workflow actions (Approve, Audit Release, Audit Status, Comment, Change Status, and Reject) 

 File Folder actions (Check In, Check Out, Cancel CheckOut, and Download) 

 Class-specific actions (such as Incorporate and Unincorporate for Items) 

 Process extensions 

Many of these actions can be grouped together. Two of them, Change Status and New, can only 
exist in their own action groups. 

To define action groups, click Action Groups in the navigation pane of the Portlet Configurator. The 
followin ppear: g options a

 on group. 

 

ber of actions in the group, the additional actions 

Action Group – Enter the name of the acti

Number of Actions to Display as Buttons – Specifies how many actions to display as buttons. If you 
select 0, all actions will appear in a menu with the same name as the action group. If you select 
a number greater than 0 but less than the num
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will be listed in a menu with the name “More.” 

 Available Actions – Displays the list of available actions for the object class. 

Selected Actions – Select action s to add to the group. Actions appe rtlet in the order 

Note e order of actions, select a column and click 

ar in the po
they are listed. 

To change th  or  to move it 
up or down. 

 

n action to the Available Actions list. For more 
s from within Portlets

 Rename – Renames the selected action. If you change the name of an action, the original Agile
name appears to the right of it in parentheses. 

 New Action – Adds a new process extensio
information, see “Using Process Extension  (on page 47)”. 

h the current settings. 

 Add button – Adds the new actions group. 

 Update button – Updates the selected action group wit

 Delete (X) button) – Deletes the selected action group. 

The following figure shows an actions group that has been defined for Workflow Actions. 

 

The following figure shows how the Actions toolbar looks in the portlet. Notice that New Object, 
Change Status, and Common Actions display as drop-down menus, and Workflow Actions only 
shows two buttons because the Number Of Actions to Deploy As Buttons option has been set to 2. The 
remaining actions in the Workflow Actions group, Audit Release, Audit Status, and Comment, 
appear on the More drop-down menu. 
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Adding the Edit Action to an Actions Group 

The Edit action is important because it allows users to edit an object that appears in the Busines
Object portlet. If you do not add the Edit action to any Actions Groups, the Business Object portlet 
will be read-only for all users. 

s 

t, it may be read-only for some 
users. Agile PLM privileges determine whether a user has rights to modify an object. If you do not 

The Change Status action for routable objects is a special action that behaves differently from other 

ss and adds them to the Actions toolbar. However, the workflow 
cted for that actions group. 

If you choose to use the Change Status action, make sure it is the only action in the group. You can 

The New action 

Even if the Edit action has been added to Business Object portle

have the Modify privilege for a particular object, the Edit action is disabled. 

Adding the Change Status Action to an Actions Group 

actions. If you add the Change Status action to an action group, it dynamically generates the list of 
status types from the object cla
status actions replace all other actions you may have sele

call the group Change Status. 

Adding the New Action to an Actions Group 

The New action allows you to create any of the objects that the portlet supports. 
appears as a drop-down menu in the Business Object portlet. 

 

 

n cannot be grouped with other actions. It must be the single action addThe New actio ed to a group. 
If you add the New action to a group with other actions, it won’t appear in the portlet. 

Note The New action is not supported by User Profile portlet and Report objects. 
Consequently, you cannot use Agile portlets to create users or reports. 

When you create a new object within the Business Object portlet, the portlet usually displays a New 
ch as the subclass and object Object dialog box with the fields needed to define the new object (su

number). 
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ence and an autonumber is 
bject is created using the next 

port ne of the Portlet Configurator. 

 
 ate to be used. 

  
elow it. 

top left of the portlet. If the 

ne attributes to the header. 
r Page One 

ion of Change]. 

t 
 object class and all its subclasses. You can also define layouts that are 

 a Default layout for the Changes object class, 

 ttribute Groups – Select an attribute group and click > to add it to a form or tab. 

 
 Form – If 

tables. 

d to add it to the Tabs box. 

 Tabs – If you chose the Tabbed layout template, use the different tabs to arrange attribute 

If the portlet supports only one subclass and one autonumber sequ
required, the New Object dialog box does not appear and the o
autonumber. 

Portlet Layout 

After specifying the properties and content of a Business Object portlet, you can configure the 
let layout. To define the layout, click Layout in the navigation pa

The Layout window allows you to: 

Construct a portlet header. 

Select the layout templ

 Arrange the attribute groups and tables within the layout. 

The following options appear in the Layout window: 

Display Object Status – Check this box to display the object’s status at the top right of the portlet.
If the Actions toolbar is shown, the status appears b

 Use Portlet Header – Check this box to display a custom header at the 
Actions toolbar is shown, the portlet header appears below it. 

 Construct Header – Use the list of attributes to the right to add Page O
n display the object’s Number, Description, Status, or otheIn that way, you ca

attributes in the header. You can also type attributes directly in the field, such as [Number]: 
[Descript

 < Add – Adds the selected Page One attribute to the portlet header. 

 Define Layout For – Select the object class for which you wish to define a layout. The Defaul
layout applies to the
subclass-specific. For example, you can define
but define a separate layout for the ECO subclass. 

 Layout Template – Select either the Form or Tabbed layout template. 

Available A

Available Tables – Select a table and click > to add it to a form or tab. 

you chose the Form layout template, use the form to arrange attribute groups and 

 Tab Name – Type the name of a tab name to use, and click Ad
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groups and tables. 

 Add >> – Adds the configuration to the layout. 

 Update >> – Updates the configuration of the layout. 

 Defined Layouts – Displays the layouts that have been defined for each object class. Select one 
to edit it. 

Note Attribute groups always display first, followed by tables, in both the Form or 
Tabbed layout. This is true even if you move a table above an attribute group in 
the list. 

The following figure shows the configuration for a tabbed layout. 
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The following figure shows the configuration for a form layout. 

 
 

Messaging Between Portlets 
The portlet.messaging parameter of a portlet allows you to define how a portlet updates itself, the 
page, or other portal pages. Objects that are listed in A
portlet—a

gile portlets—such as in a Search Results 
s a message to its 
t appears, or 

t to 
t e 

Whe fy a portlet’s portlet.messaging parameter, you can specify the following values: 

 
rds, object links in the portlet 

ll 

until you log out of 

ppear as standard links. When you click an object link, the portlet send
intended target. The target can be the same portlet, the page on which the portle
another page specified by its URL mapping. The context of the object that you’ve clicked is sen
h target, which causes it to be updated. 

n you modi

 an empty string ("") – uses the default portlet messaging. 

page – updates the current page. 

 none – does not send a message to other portlets. In other wo
appear as normal text. 

 an internal portal URL – updates another page specified by URL mapping. The URL must be a
lower case. 

Important Changes to the portlet.messaging parameter do not take effect 
the portal and log in again (to clear the cache). 

If the portlet.messaging parameter is missing from a portlet or the parameter value is a null string, the 
rtlet messaging behavior. For objects supported by the Business Object 

des the portlet.messaging parameter and always messages to itself. For 
je t 

to s ge to the page. 

portlet uses the default po
portlet, the portlet overri
ob cts that are not supported by the Business Object portlet, the default behavior is for the portle

end a messa
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If you want the Business Object portlet to message to other portlets on the same page when you 
click a link for a particular class of objects, make sure 

 the por ing parameter for the Busines let is set to page 

ss Object portlet is  to support the class. If the Busin bject 
rts a class, it will e to itself when you click a link for an object of 

or more information on how to se e Portlet Parameters

tlet.messag s Object port

 the Busine
portlet suppo

 NOT configured
 always messag

ess O

that class. 

F t portlet parameters, see “Setting Agil  (on 

learing Portlets If Mess

clearPortletContentsIfMessageNotSupported parameter can be used to clear the contents of a 

llowing portlets: 

siness Object portlet that supports only Items) 

Specify th

page 19)”. 

C aging Is Not Supported 

The 
portlet if a message received from another portlet (such as a Search portlet) is not supported. Use 
the clearPortletContentsIfMessageNotSupported parameter in conjunction with the portlet.messaging 
parameter to determine how portlets get updated when you click a link in them. 

For example, let us create a portal page with the fo

 Advanced Search 

 Search Results 

 Business Object Portlet - Changes (a copy of the Business Object portlet that supports only 
Changes) 

 Business Object Portlet - Items (a copy of the Bu

e following portlet parameters: 

Port le t  Parameter  Va lue  

ssaging pageSearch Results portlet.me

ing pageBusiness Object Portlet - Changes portlet.messag

clearPortletContentsIfMessageNotSupported true 

Business Object Portlet - Items portlet.messaging page

otSupported true clearPortletContentsIfMessageN

 
 

Exporting and Importing Portal Configurations using the 

Web s an XML configuration interface that allows you to configure the 
r 

usin ection. You can use the tool to export the portal settings from a test server and 
import them to a in folder. 
To invoke the c

XML Configuration Interface 
Sphere Portal Server provide

portal remotely. The XML configuration interface is a command line tool that connects to the serve
g an HTTP conn

 production server. The command line client is located in the <wps_root>\b
lient, use the xmlaccess.bat script. 
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The syntax for the xmlaccess command is as follows: 
xmlaccess -in XML_file -user user -pwd password -url PortalConfigURL -out filename.xml

Note You can specify the command options in any sequence. 

The xmlaccess command can be used to: 

 Transfer a complete portal configuration 

 

 
 Perform ad

For info  the IBM 
WebSphere In

To export the We al Server configuration: 

erface: 

ml -user wpsadmin -pwd wpsadmin  
fig -out Complete.xml

Transfer a portal page 

 Transfer a portal page and its portlets 

Create and modify resources 

ministration tasks 

more rmation about the WebSphere Portal Server XML configuration interface, see
foCenter. 

bSphere Port

1. In a command prompt window, go to the location of the XML Configuration Int

cd <drive>:<wps_root>\bin

2. Run the following xmlaccess command to export the entire portal configuration to a file called 
Complete.xml: 

xmlaccess.bat -in ../doc/xml-samples/Export.x
-url http://hostname:9081/wps/con

You can use the resulting output file as the input parameter for the  command to import 
the portal configuration on another portal server. 

xmlaccess

n on another server: 

2. n Interface: 

3. 
xported: 

d wpsadmin  

To import the WebSphere Portal Server configuratio

1. Copy the latest AgilePortletPack2.war file to the <wps_root>\installableApps folder of the target 
server. 

In a command prompt window, go to the location of the XML Configuratio

cd <drive>:<wps_root>\bin

Run the following xmlaccess command to import the portal configuration from the Complete.xml 
file that you previously e

xmlaccess.bat -in Complete.xml -user wpsadmin -pw
-url http://hostname:9081/wps/config -out Out.xml

Note If the target server has a different portal administrator than the one used to 
export the Complete.xml file, edit the file and change the user and pwd 
parameters. 

 

Us
Agile PLM 9.2.2.3 inclu M process extensions 

insta

ing Process Extensions from within Portlets 
des a special web service that lets you invoke Agile PL

from within a portlet. The web service is contained in a file named PXWebService.jar, which is 
lled in the following folder on the Agile PLM server: 

agile_home\integration\sdk\extensions 
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For information about how to develop and deploy process extensions, see the Agile SDK 

To configure your portal to use process extensions: 

http://<server>:<port>/<virtualPath>/integration/ws/InvokePX?wsdl 

 on a server named plmserver, you’re hosting Agile PLM 
sing a virtual path named “Agile,” 

rver:7777/Agile/integration/ws/InvokePX?wsdl

more 
Developer Guide. 

1. Before using a process extension from within a portlet, check to make sure PXWebService is 
working. Open a browser and type the following URL: 

For example, if you installed Agile PLM
on Oracle Application Server using port 7777, and you’re u
type the following URL: 

http://plmse

You should see a WSDL response in the browser. If you don’t, the web service may not have 
re 

2. et application parameter has been configured 
corre tly. This should be the same as the URL used to access the Agile Web Client, but without 

ervlet”. For more information, see “Setting Agile Portlet Services Application 

been deployed properly. Make sure you installed the latest Agile PLM service packs. For mo
information about how to check whether Agile PLM web services are working, see the Agile 
PLM installation guide. 

Make sure that the webClientVirtualPath portl
c

the trailing “/PLMS
Parameters (see "Setting Agile Portlet Parameters" on page 19)”. 

ce on the Agile PLM server. Make 
Portal has Basic Authentication enabled. In 

you can enable Basic Authentication from the Directory Security 

 Portlet 

When you use  appear 
at the top of th ns, like Bookmark, Delete, Print, and SaveAs, 

To c

1. 

 the configuration to the 

3. Click the 

4. In the Portlet Configurator Login dialog box, enter your username, password, and the Agile 
PLM server URL. Click OK to log in. 

3. Portlets use Basic Authentication to invoke the PXWebServi
sure the Web server used by your WebSphere 
Internet Information Server, 
tab. 

 

Configuring a New Process Extension Action for a

 the Portlet Configurator to configure a portlet, you can select the actions that
e portlet. In addition to standard actio

you can add custom actions that invoke process extensions. 

onfigure a new process extension action: 

Configure a portlet based on the Business Object portlet. 

2. In the XML Configurator window, click the Copy button to copy
Clipboard. 

Launch Configurator link to open the Portlet Configurator window. 

The Portlet Configurator window appears. 

5. Click  Paste. 

6. Click the Configure tab. 

7. In the navigation pane, click Action Groups. 

8. Click the New Action button. 
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9. In the Action Name field, type a name for the custom action. 

Note

10. In the Process Extension field, select a valid process extension. 

 The Portlet Configurator displays all process extensions, not just the ones that 
have been assigned to a particular class. Only process extensions that have 
been assigned to the class are valid. 

11. If you se -based process extension (one that links to another Web page or a Web-
bas p reshed 
after you sion page. If the process extension updates the object that 
laun d

12. You can the custom action in any Action Group. 

Note

lected a URL
ed a plication), check the Refresh Parent box if you want the parent portlet to be ref

 close the process exten
che  the page, you can use this option to refresh the portlet. 

 now include 

 In the XML, the process extension action looks like any other action but has the 
ref-id "%common.invokePX". Do not modify the ID of this pro
action. 

cess extension 

 

Testing

The Agil source code 
grams, download the Developer 
n Web Site (http://docs.agile.com

 a Sample Process Extension within a Portlet 

e SDK includes a sample process extension, SamplePXes.jar. To obtain the 
for SamplePXes.jar and other Agile SDK sample pro
Documentation Installer from the Agile Documentatio ). Follow the 
instructio in nd deploy SamplePXes.jar in the 
agile_ho onfigure the “Set Description” 
process exte

To test th  portlet: 

1. Buil gile SDK. 
java.sun.com/

ns  the Agile SDK Developer Guide to build a
me\integration\sdk\extensions folder. You also need to c

nsion using the Agile Java Client. 

e Set Description process extension from within a

d and deploy the sample process extensions included with the A
a. Download the Java SDK from http://  and install it on your development 

me directory of your Java SDK 
machine. 

b. Set the system variable JAVA_HOME to point to the ho
installation. 

c. Download the Ant build tool from http://ant.apache.org/ and install it on your 
development machine. 

d. Set the system variable ANT_HOME to point to the home directory of your Ant 

pen a command prompt window and go to the Process Extensions samples folder 

 SamplePXes.jar file and then deploy it to the 
s folder, where all process extensions and web 

 deployed for clients that invoke them. 

2. Ena t
va Client as an administrator. 

installation. 
e. O

located in agile_home\integration\sdk\samples\px. 
f. Type the following command to build the samples: 
%ANT_HOME%\bin\ant all 

Ant uses the build.xml file to build the
agile_home\integration\sdk\extension
service extensions are automatically

ble he Set Description process extension. 
a. Log into Ja
b. Choose Settings > Data Settings > Process Extensions. 
c. Click the New toolbar button. The Add Process Extension dialog box appears. 
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d. For Type, select Internal Custom Action. 
For Internal Custom Action, selecte.  samplepx.SetDescription. 

 

 
rrent user, leave the field blank. 

 default value (60 seconds). 

3. Click 

4. Add s. 
Classes. 

 toolbar button. 
e 

ected list. 

5. In th ption process extension as a custom action and 
assi

rtlet, that is, a Business Object portlet 

 Copy button to copy the configuration to the 

igurator link to open the Portlet Configurator window. 
ter your username, password, and the 

tor window appears. 

f. Enter values in the following fields: 
Name – Enter “Set Description.” 

 Description – Enter “Sets the description of the object.” 
 Initiate From – Select “Actions menu.” 

Roles – Select one or more roles to use for the process extension. To use the roles 
and privileges of the cu

 Timeout se the– U
 Enabled – Select Yes. 
OK. 

 the Set Description process extension to the Item clas
a. In Java Client, choose Settings > Data Settings > 
b. Open th Items class. e 
c. Click the Process Extensions tab. 
d. Click the Assign
e. Select the “Set Description” process extension, and then click > to move it into th

sel
f. Click OK. 
e Portlet Con urator, add the Set Descri

t
fig

gn i  to the Item class. 
a. Edit a portal page that has an Item Po

configured for the Items class. 
b. In the XML Configurator window, click the

Clipboard. 
c. Click the Launch Conf
d. In the Portlet Configurator Login dialog box, en

Agile PLM server URL. Click OK to log in. The Portlet Configura

e. Click  Paste. 
f. Click the Configure tab. 
g. In the navigation pane, click Action Groups. 
h. In the Action Groups field, type “Custom Actions”. 
i. Click the New Action button. 
j. For Action Name, type “Set Description.” 
k. For Process Extension, select “Set Description.” 

> Selected 
l. Click OK. 

6. Select the “Set Description” action, and then click the  button to move it into the 
Actions list. 

a. Click the Add button to move “Set Description” into the Custom Actions action group. 

b. Click  Copy. 
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c. Switch to the XML Configuration window, and click Paste. 
d. Click Save to save the configuration. 
e. Click Return to return to the portlet page. 

7. Invoke the Set Description process extension and verify that the Item Description is now 

ou 

Because Agile portlets are so flexible and customizable, static online help files are not provided with 

ase URL for help files. To specify the base 
ter. For each portlet, enter a value for the 

andler 
 URL to the help 

 

assigned to a random value. 
a. Open a portal page that has the Item Portlet. 
b. Search for or select an item to display data in the Item Portlet. 
c. Choose Custom Actions > Set Description. 
Y should see the new value in the Description field. 

Creating Custom Help for Agile Portlets 

them. However, you can create your own custom online help files. You can choose one of two 
online help scenarios for each Agile portlet: 

Using Relative References to Help Files

With this scenario, all Agile portlets share the same b
URL, enter the help.base.url application parame
help.relativePath portlet parameter, which specifies the relative path to a help file. The help h
for Agile portlets combines the base URL and the relative URL to form the complete
file.

For example, if the help.base.url value is http://webserver/portlethelp, the help.relativePath
anced Search portlet could be AdvancedSearch.html. The complete URL that is used to access 
file is 

 for the 
Adv
the http://webserver/portlethelp/AdvancedSearch.html. 

Using Absolute References to Help Files

With this scenario, each portlet specifies its own help file. You can use the help.url portlet parameter 
to override the help.base.url application parameter and the help.relative.path portlet parameter. 

For example, if you created help for the Advanced Search portlet and deployed i
named “portal”, the help.url value could be 

t on a Web server 
arch.htmlhttp://portal/docfiles/AdvancedSe . 

Note If there is a value in a portlet’s help.url parameter, it overrides the 
help.relativePath portlet parameter and the help.base.url application parameter. 

 

Downloading Online Help Files for Agile Portlets 

elp, open a Web browser Agile provides HTML help files for Agile portlets. To download portlets h
and go to the Agile Documentation Web site: http://docs.agile.com. 

nfigur gile portlets to use the downloaded online hTo co elp files: 

 help archive file for Agile portlets. 

3. Create a folder called AgilePortletHelp in your Web server's docroot directory. 

e A

1. Download the

2. Extract all files from the help archive file. 
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4. Copy the portlet help files to the AgilePortletHelp folder. 

5. Set the help.base.url application parameter for AgilePortlets 2.1 to the URL for the 
AgilePortletHelp folder (for example, http://Web Server/AgilePortl
instructions, see “Setting Agile Portlet Services Application Parame

etHelp). For complete 
ters (on page 11)”. 

ets on WebSphere Portal 5.1.0.4 

n WebSphere Portal 5.1.0.4, follow 

le portlets to use a base help URL on WebSphere Portal 5.1.0.4: 

te instructions, see 

 

Configuring Online Help for Portl

If you want to create custom online help s for Agile portlets ofile
these instructions. 

To configure Agi

1. Set the help.base.url application parameter for AgilePortlets 2.1. For comple
“Setting Agile Portlet Services Application Parameters (on page 11)”. 

2. Click Portlet Management > Portlets. 

3. Select an Agile portlet, and click the  Configure Portlet icon. 

4. For the help.relativePath parameter, click the  Edit Parameter icon. 

5. In the Value box, enter a URL that is relative to the help.base.url setting for Agile portlets. For 
example, the value could be an HTML filename. 

6. Click OK. 

7. Select other Agile portlets and configure their help.relativePath parameter in the same way. 

5.1.

WebSphere Portal Server as a po

To configure an Agile portlet to override the base help URL and use its own help URL on WebSphere Portal 
0.4: 

1. Log into the rtal administrator. 

2. Click Administration. 

3. Click Portlet Management > Portlets. 

4. For the help.url parameter, click the  Edit Parameter icon. 

5. In the Value box, enter a help URL. 

here Portal 6.012 

r Agile portlets on WebSphere Portal 6.01, follow 
s. 

 configure Agile portlets to use a base help URL on WebSphere Portal 6.01: 

1. Set the help.base.url application parameter for AgilePortlets 2.1. For complete instructions, see 
“Setting Agile Portlet Services Application Parameters

6. Click OK. 
 

Configuring Online Help for Portlets on WebSp

If you want to create custom online help files fo
these instruction

To

 (on page 11)”. 

2. Click Portlets > Manage Portlets. 

3. Select an Agile portlet, and click Modify Parameters. 

4. Enter a URL that is relative to the help.base.url setting for Agile portlets. For example, the value 
could be an HTML filename. 
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5. Click Save. 

6. Select other Agile portlets and configure their help.relativePath parameter in the same way. 

To configure an Agile portlet to override the base help URL an
6.01: 

1. Log into the WebSphere Portal Server as a portal administrator. 

3. Click Portlets > Manage Portlets. 

4 S

5 E

6 C
 

d use its own help URL on WebSphere Portal 

2. Click Administration. 

elect an Agile portlet, and click Modify Parameters. . 

. nter a value in the help.url parameter. 

. lick Save. 
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Chapter 4 

Using Agile Portlets 

This chapter includes the following: 

 
 Using Edit Mode to Personalize Agile Portlets .................................................................................................... 56
 Filtering Data in Portlets ...................................................................................................................................... 56
 Advanced Search Portlet ..................................................................................................................................... 57 
 Attachment Files Portlet.........................................................................

Agile Portlet Features .......................................................................................................................................... 55 
 
 

.............................................................. 60 
Bookmarks Portlet 61 
Bus

 Clip
 My ............................................................................................. 64 
 My Things To Do Portlet ...................................................................................................................................... 64 
 Quick Links Portlet............................................................................................................................................... 66 
 Quick Navigation Portlet ...................................................................................................................................... 66 

........................................................................................................................ 68 

........................................................................................................................ 69 
 
 
 

............................................................................................................ 73 

............................................................................................... 75 
 

le Po ures
Each Agile portlet is a small Web-base splays 
data in tabular format. For example, F  of 
search results after you click the Sear

If you click an object’s number link in e a 
Business Object portlet. 

Many of the Agile portlets have comm
an object in the Agile Web Client. Several Agile portlets let you perform relevant actions—such as 
Bookmark or Subscribe—for each obj

To refresh the data in an Agile portlet: 

Click 

 ...............................................................................................................................................
 iness Object Portlet ....................................................................................................................................... 62 

board Portlet .................................................................................................................................................. 63 
 Notifications Portlet ...........................................

 Quick Search Portlet....................
 Report Folder Browser Portlet .....
 Saved Search Portlet........................................................................................................................................... 70
 Search Folder Browser Portlet............................................................................................................................. 71
 Search Results Portlet ......................................................................................................................................... 72
 Single Signon Portlet ...............................
 Upload File Portlet ............................................................................................................................................... 74 
 User Profile Portlet............................................................................................................................................... 75 
 Sending Portlet Errors to the Portal Administrator

 

Agi rtlet Feat  
d application that connects to the Agile server and di

ind portlets like the Quick Search portlet display a table
ch button. 

an Agile portlet, you load data in other Agile portlets, lik

on controls that let you refresh data from the server or view 

ect listed in the portlet. 

. 

Agile Product Lifecycle Management Page - 55 

 

 



Portlet Services Installation and Configuration Guide  
 
 
 

Using Edit Mode to Personalize Agile Portlets 
Portal users ca  po nce. 
When you pers affe

The following Agile portlets can be pe

 Advanced Search 

Attachmen

 Business Object 

 My Notifications and Requests 

 My Things To Do 

ick Link

 Report Folder Browser 

 Saved Search 

rch Fo ser 

 Single Signon 

 User Profile 

Most portlets have a simple Edit mode  
Object and User Profile portlets both u ey 

u  the Portlet C e portlets. The Quick Links 
es on L Configurati  If you are not proficient at 

 XML, d mpt to person

To use Edit mode to personalize an Agile portlet: 

. Select a portal page. 

n personalize Agile
onalize a portlet, it 

rtlets to change the display to their own personal prefere
cts the portlet only for you, not for other users. 

rsonalized: 

 t Files 

 Qu s 

 Sea lder Brow

 user interface to personalize the portlet. The Business
se the XML Configuration window for Edit mode, but th

also allow yo
portlet us

to launch
ly the XM

onfigurator to personalize thos
on window for personalization.

editing o not atte alize the Quick Links portlet. 

1

2. Click the  Edit icon (a pencil) for a portlet. 

3. Edit the configuration. 

For some portlets, you can click Use Defaults to revert to the default configuration specified by 

4. Click

5. 
 

Fil
The ata from tables: 

 y Things To Do 

the portal administrator. 

 Save. 

Click Return to return to the portlet. 

tering Data in Portlets 
 following Agile portlets provide a filter bar that lets you filter out d

M

 My Notifications and Requests 
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 Saved Search 

 Search Results 

To use the filter b
rows in the table,

ar, select an attribute from the list, type a value, and then click Filter. To show all 
 click Show All. 

 
 

Advanced Search Portlet 
ns of the 

sea e p nd 
attributes that igured 
to search. Afte

 will not work if there are more than ONE searchable TEXT attributes 

The Advanced Search portlet searches for all objects with fields that match the conditio
rch. Th ortlet must be configured properly before it can be used on a page. The fields a

 you can use in an advanced search depend on the class that the portlet is conf
r you specify the search conditions, click Search. 

Note Auto Complete
configured: This limitation seems to only be an Internet Explorer issue. Auto Complete for 
the FireFox browser works perfectly.  

 
 

Using Advanced Search 

 Each attribute appears in the Advanced Search portlet as a separate search condition. For 

The each search condition depends on the data type of its attribute, as 

The Advanced Search portlet can be personalized to search on multiple attributes for a particular 
class.
each search condition, specify a value. 

 relational operator used for 
shown in the following table. 

Data Type Relat iona l  Notes  
Operator  

Text Contains or Like Specify a text value. When you type a word to search for, it’s 

can also use wildcard characters (* and ?) in the search 
, in which case the Like operator is used. Agile supports two 

mark finds matches with any other single character. For example, 
finds hat, cat, and fat, but not splat. The asterisk finds matches 
 more than one character. For example, *at finds cat, splat, 

because it matches too many rows in the database. 

searched using the Contains relational operator. That means the 
search finds all objects that contain the word in that field. 

You 
value
wildcards: the asterisk (*) and the question mark (?). The question 

?at 
with
and big hat. The asterisk by itself finds all objects of the specified 
class. 

Note: If you use ildcards, try to make your search as narrow as 
possible. Otherwise, the search may not be able to return results 

 w
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Data Type Relat iona l  Notes  
Operator  

Date Greater Than or Equal Specify starting and ending date values. The relational operator 
used in the search range of dates you specify. If 
you specify only th e search finds any date values 

qual to it. If you specify only the ending 
date, the search finds any date values that are 

earch 

To, Less Than or 
Equal To, or Between 

 depends on the 
e starting date, th

that are greater than or e
less than or equal 

to it. If you specify both the starting and ending dates, the s
finds any date values that fall within the specified range. 

List Equal To s, the 
kground 

em using the OR logical operator. For example, if 
 “Production, Prototype” for the Lifecycle Phase attribute 

Select one or more list values. If you select multiple list value
search constructs multiple search conditions in the bac
and connects th
you select
(as shown above), the search returns items whose Lifecycle 
Phase is equal to “Production” or “Prototype”. 

Money Equal To  value to search, not a currency code. When you 
oney values are converted to the company’s 

corporate currency to determine if they match the value you 
specified. 

Specify a numeric
run the search, m

MultiList Contains Select one or more list values. The search finds any matches that 
contain any of the specified list values, not all of them. If you 
select multiple list values, the multiple search 
conditions in the background and connects them using the OR 

, if you select “Equipment, PDA” for 
shown above), the search returns 

tains “Equipment” or “PDA”. 

search constructs 

logical operator. For example
the Product Line(s) attribute (as 
items whose Product Line(s) field con

Numeric Equal To Specify a numeric value to search. 

UOM Equal To the 
type “5” or “5.0”. 

Specify a numeric value, not a unit of measure. For example, if 
value you are searching for is “5.0 Gram”, 

 

The logical operator AND ify. For example, 
in the Advanced Search screen, the following logic applies: 

Search for Items where 

r]
 Block iption] Contains BOARD AND
ifecycle Production" OR

tle Block.Lifecycle ") AND
([Title Block.Product Line(s)] Contains "Capricorn" OR
[Title Block.Product Line(s)] Contains "Leo") AND

 02/01/06 and 05/01/06 

 is used between multiple search conditions that you spec

 is Like P0017* AND
.Descr

[Title Block.Numbe
[Title

([Title Block.L  Phase] is Equal To "

[Ti  Phase] is Equal To "Prototype

[Title Block.Rev Incorp Date] is Between

 

When you finish specifying values to search for, click Search. 
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To save your search so you can reuse it later, click  Save Search. 

To clear search criteria and start a new search, click Clear. 

R” 

 

 

OR Searches 

To do an “or” search, type two words separated by a space. For example, “FUSE TRANSISTO
will find all objects that contain either “FUSE” or “TRANSISTOR” in that field. 

AND Searches 

To do an “and” search, type a second word prepended with a plus sign. For example, “INTEL
+PENTIUM” will find all objects that contain both “INTEL” and “PENTIUM” in that field. 

Note Do not put a space between the plus sign and the second word. For example, 
“INTEL + PENTIUM” is not a valid search value. 

 

AND NOT Searches 

To do an “and not” search,
PENTIUM” will find all obje

 type a second word prepended with a minus sign. For example, “INTEL -
cts that contain “INTEL” but not “PENTIUM” in that field. 

Match ct Phrases 

tch” s rounded by quotes. For example, “LOAD 
BALANCE  phrase “LOAD BALANCER” phrase in that 

an’t combine “exac  “and” or “or” searches. For example, 

AD BALANCER” 

 search valu

ghtly more complex Edit mode options than other Agile portlets. 

1. Select a portal page with the Advanced Search portlet, and click the 

ing Exa

To do an “exact ma earch, type a word or phrase sur
R” will find all objects that contain the 

field. 
exact

You c t match” searches with

“LO +IBM 

is not a valid e. 

Personalizing the Advanced Search Portlet 

The Advanced Search portlet has sli
You can select one of the defined searches, and specify the search fields and output fields. 

To personalize the Advanced Search portlet: 

 pencil icon to enter Edit 

rches. 

mode. 

2. Select one of the defined sea

3. Select fields to search, and then click the  right arrow to move them into the Selected 
Attributes box. 

4. Select search output fields, and then click the  right arrow to move them into the Selected 

om either of the Selected Attributes lists, select it and then click the 

Attributes box. 

5. To remove a field fr  left 
arrow. 

6. Click Update to update the search. 
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7. Click Return to return to the portlet. 
 

Edit Mode Options 

Opt ion  Descr ipt ion 

Select Search Select one of the predefined searches. 

Select Fields to Search Select search attributes by moving them into the Selected Attributes list. 

Select Search O
Fiel

ributes list. 

utput 
ds

Select attributes that appear in the search results. Move attributes from the 
Available Attributes list to the Selected Attributes list. You can also sort 
attributes by moving them up or down in the Selected Att

Update Saves the configuration. 

Return Returns to the page without saving. To save the configuration, make sure you click 
Update first. 

Use Default 
Configuration

Uses the default search criteria. 

 
 

Configure Mode Options 

Opt ion  Descr ipt ion 

Select Class to Search Select the class used to search for objects. 

Define Search For Select the class you are defining search criteria for. 

Select the Attributes to 
Include as “Advanced” 
Search Parameters

Select attributes that users can use to search. Move attributes from the Available 
Attributes list to the Selected Attributes list. You can also sort attributes by 
moving them up or down in the Selected Attributes list. 

Select Attributes to 
Display in the Search 
Results

Select attributes that appear in the search results. Move attributes from the 
Available Attributes list to the Selected Attributes list. You can also sort 
attributes by moving them up or down in the Selected Attributes list. 

Add or Update Creates or updates the search definition. 

Exclude Inactive Values To exclude any inactive list values from search results, make sure this box is 
checked. for List Attributes

Save Saves the configuration. 

Return Returns to the page without saving. 

 

use one of the Search portlets to find an object with an Attachments table, such as an item or 

 

Attachment Files Portlet 
Shows a selected object’s Attachments table. To use the Attachment Files portlet, you must first 
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change. You can use the Attachment Files portlet to open, download, add, checkout, cancel 
checkout or check-in a file, as well as click a file to view it in the Agile Viewer. 

 

To dis y the attachments table, select values for the Site and Rev. By default, the portlet shows 
all site nd the Introductory revision. 

de Options 

pla
s a

Edit Mo
Opt ion  Descr ipt ion 

Available Attributes Lists available attributes for the table. 

Selected Attributes Lists attributes you selected. 

Save Saves the configuration. 

Return Returns to the page without saving. 

Use Defaults Uses the default configuration. 

 
 

Configure Mode Options 

Configure mode has the same options as Edit mode, except it does not have the 
See “Edit Mode Options

Use Defaults option. 
 (on page 60)”. When you save settings in Configure mo

the default settings for the portlet. 

Bookmarks Portlet 
Shows the current user’s Agile PLM bookmarks. You can define new Agile PLM boo
Agile PLM clients, including the following Agile portlets: 

 Business Object 

de, they become 

kmarks from 

 Saved Search 

 Search Results 

Agile Bookmarks are also listed in the Quick Navigation portlet. 
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Business Object Portlet 
 

s, the Business Object portlet allows you to create 
 
 

lecting the presentation of data appropriate for your users. 

Shows data for Agile PLM business objects (such as items or change orders). Easily the most
powerful and most customizable of Agile’s portlet
portlets that display different types of Agile PLM business objects. The Business Object portlet can
be configured to support multiple object classes. You can use the Portlet Configurator to customize
the content and layout of the portlet, se

Note For the Business Object Portlet, the PX menu Configuration in the Configurator 
is assigned to Base Classes, not Classes or Subclasses. 

 

bject por sses: 

 Changes 

s 

ems 

nufacturer Parts 

 Manufacturers 

 Programs 

 User Groups 

ser 

The Business O tlet supports the following Agile PLM cla

 File Folder

 It

 Ma

 Reports 

Additionally, the Portlet Configurator allows you to configure the Users class to support the U
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Profile portlet. 

Other portlets, such as the Search Results portlet, can message to the Business 
update its content when you click an object link. After you view a series of different obje

Object portlet to 
cts in the 

the portlet to backtrack Business Object portlet, you can use the “breadcrumbs” feature at the top of 
to previously viewed objects. 

 

 

For information on how to use the Portlet Configurator to configure the Business Obje
“Using the Portlet Configurator

ct portlet, see 
 (on page 33)”. 

Note Using "Transfer Authority","Change Password" and "Change Approval Password" in the 
Business Object Portlet generates a "This portlet is unavailable" error. The "Edit" and 

Note d a file attachment to an obje  Object Portlet, make sure 
ave Modify privileges to the F iption field. 

"Print" actions are fine. 

To ad
you h

ct displayed in the Business
ile Folder’s Title Block > Descr

 

Clipboard Portlet 
ect Agile PLM ns on them. Lets you coll  objects to later perform actio

 

lipboard is a tempor  the user’s current portal session. Each user can 
fferent things in th he list of objects in the Clipboard to quickly 
 objects. When yo pty. When you add objects to the 

The C ary storage portlet for
store di
retrieve

e Clipboard. You can manage t
u first log in, the Clipboard is em
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C
o

lipboard, they remain there until you empty the Clipboard, click Remove or Empty to remove them, 
r terminate the portal session. 

t with the Windows Clipboard. You cannot use the Clipboard 
 the Windows Clipboard. It is used only to copy and paste 

objects between Agile portlets. 

 action to 
ay contain 

sted. 

Do not confuse the Clipboard portle
portlet to copy and paste objects to

You can add objects to the Clipboard from other Agile portlets. Select one or more rows and then 
choose the Copy To Clipboard action. 

On any editable table in the Business Object portlet, you can use the Clipboard > Paste
paste the contents of the Agile Clipboard into the table. Although the Agile Clipboard m
disparate objects (such as Items and Changes), only objects supported by the table are pa

Note You do not need to place the Clipboard portlet on a portal page to take 
advantage of the Clipboard functionality available in other Agile portlets. 

 

My Notifications Portlet 
Shows the current user’s n
(although the portal admin

otifications. Notifications appear as separate views in the portlet 
istrator can choose to not display both). 

If you c ject link in the My Notifications portl displays a detail view of the 
ation. 

ble actions availab ortlet vary based on the view that is selected. 

lick a Sub et, the portlet 
notific

The ta le in the My Notifications p

View Avai lable  Table  Act ions  

Delete, XLS (Save Table to Excel) My Notifications 

DeleteMy Notifications - Detail 

 
 

Configure Mode Options 
Opt ion  Descr ipt ion 

Available Views Lists available views for the portlet: 

My Notifications 

Selected Views Lists views you have selected. 

Save Saves the configuration. 

Return Returns to the page without saving. 

 
 

My Things To Do Portlet 
Shows objects routed to the current user that he must act on. The My Things To Do portlet 

Page - 64 Agile Product Lifecycle Management 

 

 



 Chapter 4  
 
 

con ems, Workflow Routings, and Program Activities within one portlet (although 
the portal administrator can choose to not display all three views). You can update your 

nme ercentage. 

solidates Action It

assig nts by marking them complete or entering a completion p

 

cted. The table actions available in the My Things to Do portlet vary based on the view that is sele

View Avai lable  Table  Act ions  

My Action Items Accept, Decline, Mark Complete, Edit, XLS (Save Table to Excel) 

My Workflow Routings XLS (Save Table to Excel) 

My Program Activities Edit, XLS (Save Table to Excel) 

My Requests Accept, XLS (Save Table to Excel) 

My Requests - Detail Delete, Reject

 
 

Displaying Things To Do by Due Date 

You can display Action Items or Program Activities based on the date they are d
Due In list and select All, 1 Week, 2 Weeks, 1 Month, 2 Months, or 6 Months. 

Configure Mode Options 

ue. Click the Display 

Opt ion  Descr ipt ion 

Available Views Lists available views for the portlet: 
 My Action Items 
 My Workflow Routings 
 My Activities 

Selected Views Lists views you have selected. 

Save Saves the configuration. 

Return Returns to the page without saving. 
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Quick Links Portlet 
Lets you add links to other portal pages or to external Web pages. When you click a lin
can display within the portal or it can open within a new browser window. 

k, the page 

 

You can use the Quick Links portlet to provide users a quick way to navigate to a page for 
atio

Edit Mode Options 

inform n on how to complete a task, or provide a link to another Web application. 

Opt ion  Descr ipt ion 

Copy Copies the XML configuration. 

Paste Pastes the XML configuration. 

XML Confi on for the portlet. For more information, see 
“Configuring a Quick Links Portlet

guration Defines the XML configurati
 (on page 31)”. 

Save Saves the configuration. 

Return Returns to the page without saving. 

Use Defaults Uses the default configuration. 

 
 

Con re 

Configure mo ptions as Edit mode, except it does not have the Use Defaults option. 
When you save settings in Configure mode, they become the default settings for the portlet. See 

figu Mode Options 

de has the same o

“Edit Mode Options (on page 60)” above. 

Quick Navigation Portlet 
Lets you navigate to bookmarked or recently visited Agile PLM objects, or objects that you copied to 

 

 Recently Visited – During e r maintains a list of the last 10 
bjects viewed (or 25 ng on the server’s Preference settings). 

 Bookmarks – Agile PLM clients, including portlets, allow you to bookmark objects to later return 

the Clipboard portlet.

ach Agile PLM session, the serve
o , 50, or 100, dependi
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to them quickly. 

The Bookmarks okmarks. Note  portlet also lists Agile PLM bo

 Clipboard – Collects Agile PLM objects to later perform actions on them. You can use the Agile 
Clipboard (not to be confused with the Windows Clipboard) to copy and paste objects between 

ates the object 
 
 

Agile portlets. 

If you click an object link in the Quick Navigation portlet, it automatically upd
reference for portlets on the current page. Because the Quick Navigation portlet does not have a
portlet.messaging parameter, you cannot configure it to update the object reference for portlets on
other pages 
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Qu
Searches for Agile PLM objects by specifying a single matching value. 

ick Search Portlet 

 

The Quick Search portlet lets you quickly locate objects in the Agile system that match the tex
enter. The text must be the start of the ID number you are seeking or the beginning of a word within 
the object’s description. Quick Searches are not case sensitive. 

Select a class to search. Type the value to search for, and then click Search. The results ap
the Search Results portlet. 

Note For Quick Searches, the display fields that appear in the Search Results cannot be 

t you 

pear in 

configured. 

To perform a full-text search of files listed on the Attachments tab of objects, make sure the Search 
Attachment Contents box is checked. 

Note Auto Complete will not work if there are more than ONE searchable TEXT attributes 
configured: This limitation seems to only be an Internet Explorer issue. Auto Complete for
the FireFox browser works perfectly.  

 

 

Usi

se wildcard characters in your search. Agile uses two wildcards: the asterisk (*) and the 
ark finds matches with any other single character. For example, 
plat. The asterisk finds matches with more than one character. 

For exa  finds cat, splat, and big hat. The a  finds all objects of the specified 
class. 

If you use w rwise, 

ng Wildcards 

You can u
question mark (?). The question m
?at finds hat, cat, and fat, but not s

mple, *at sterisk by itself

Note ildcards, try to make your search as narrow as possible. Othe
the search  results because it matches too many rows 
in the data

 may not be able to return
base. 

 

gure Mode OConfi ptions 
Opt ion  Descr ipt ion 

Available Object Types Lists available object types for the Quick Search portlet. 

Selected Object Types Lists object types you selected. The order is important. The first object type listed 
is the default one used in the portlet. 

Save Saves the configuration. 
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Opt ion  Descr ipt ion 

Return Returns to the page without saving. 

 
 

Report Folder Browser Portlet 
Lets you generate reports from one of the Report folders. To generate a report, click any of the 
listed reports to open the Report wizard. 

The Report Folder Browser portlet can be used on multiple portal pages, and you can config
different settings for each page. This allows you to specify different root Report folders on diff
pages. 

ure 
erent 

 
 

Edit Mode Options 
Op n t io Descr ipt ion 

Report Tree Displays a hierarchical list of report folders. Select one to use for the portlet. 

Save Saves the configuration. 

Return Returns to the page without saving. 

Use Defaults Uses the default configuration. 

 

Configure Mode Options 

ode has the , except it does not have the Use Defaults option. 
See “Edit Mode Options

 

Configure m same options as Edit mode
 (on page 60)”. When you save settings in Configure mode, they become 
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the default settings for the portlet. 

l Reports checkbox option is not supported. Do not Note The Enable Customer Externa
check that box. 

 

Saved Search Portlet 
The Saved Search portlet displays results for a saved search. 

 

The Saved Search portlet must be configured properly before it can be used on a page. The portal 
administrator should make a copy of this portlet before adding it to a page and configuring it for a 
particular saved search. 

Click an object’s number to load its data in another portlet, such as a Business Object portlet. You 
can also perform relevant actions for each object listed, such as Copy, Bookmark, and XLS (Save 
Table to Excel). 

Note The Saved Search portlet does not support parameterized searches, which 
prompt for search criteria when you run them. 

 

Configure Mode Options 
Opt ion  Descr ipt ion 

Search Tree Displays a hierarchical list of search folders and searches. Select a saved 
search to use for the portlet. 

Save Saves the configuration and returns to the page. 

Return Returns to the page without saving. 
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Search Folder Browser Portlet 
o run. Allows you to browse search folders and select a particular search t

 

ved s h Folder Browser portlet, including parameterized 
hes, which prompt f n you run them. 

ove searches from lder, click the Organize Your Personal Searches 
link at the bottom of the portlet. Select a sea ck Delete. After that, click Return to go 
ack to the normal portlet view. 

Note For searches that you run from the Search Folder Browser portlet, the display 

You can run any sa earches from the Searc
searc or search criteria whe

To rem  your Personal Searches fo
rch, and then cli

b

fields that appear in the Search Results are determined by how the searches 
have been defined. 

 

Edit Mode Options 
Opt ion  Descr ipt ion 

Search Tree Displays a hierarchical list of search folders. Select a search folder from 
the tree to use for the portlet. 

Save Saves the configuration and returns to the page. 

Return Returns to the page without saving. 

Use Defaults Uses the default configuration. 
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Configure Mode Options 

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option. 
See “Edit Mode Options (on page 60)”. In Configure mode, the Search Tree is used to sele
base search folder for the portlet. 

Search Results Portlet 
Works in conjunction with the Advanced Search, Quick Search, and Search Folder Browse
When you run a search in one of the search portlets, the results appear in the Search Results 
portlet. 

ct the 

r portlet. 

 

s, e 
t. Y  perform relevant actions for each object listed, such as Copy, 

, and XLS (Save Table to Excel). 

From the search result
Business Object portle
Bookmark

you can click objects to display them in another portlet, such as th
ou can also

Page - 72 Agile Product Lifecycle Management 

 

 



 Chapter 4  
 
 

Single Signon Portlet 
Allows single signon between the portal and the Agile PLM server. 

 

Con
Agil e portal. 

 

figure the Single Signon portlet to specify the user ID and password used to connect to the 
e PLM system. This same connection can be used for every Agile portlets page on th

If you use Edit mode to change the Agile PLM user ID and password, make sure you log out and 
log back into the portal. 

Note If you do not configure the Single Signon portlet correctly, other Agile portlets 
will not work. 

 

Edit Mode Options 
Opt ion  Descr ipt ion 

Agile User ID The user’s unique ID for logging into the Agile PLM system. 

Agile User Password The user’s login password. 

Save Saves the configuration. 

Cancel Cancels configuration changes. 
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Upload File Portlet 
Adds new files to the Agile PLM system. Specify the path of each file to upload, or click Browse to 
select it. 

 
 

Options 
Opt ion  Descr ipt ion 

Browse Select a file to upload. 

Upload Files to the 
Same File Folders

To upload files to the same folder, check this box. Otherwise, a separate 
folder is created for each file. 

Unzip all Zip Files and 
Add Them as Individual 
Files

If the file is a Zip file (an archive format), check this box to unzip the file when 
you upload it. 

Type Select the File Folder type. 

Description Enter a brief description of the file. 

Upload File Creates a file folder containing the specified file. After the file is uploaded, 
click Done to return to the portlet. 
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User Profile Portlet 
Lets you view and edit the Agile PLM user profile for the current 
portlet is based on the Business Object portlet, but it is specifical

For information on how to use the Portlet Configurator to configure the User Profile portlet, see 
“Using the Portlet Configurator

logged in user. The User Profile 
ly for the User class. 

 (on page 33)”.  

Note If you change the password in the User Profile portlet, make sure you reset the 
password used in the Single Signon portlet as well. 

 

S n
If  e

The system did not perform as expected. Please contact your Portal Administrator. 

ere should also be a link below it that reads Send Error To Portal 
pen your default email client and send the contents of the error 

 

e ding Portlet Errors to the Portal Administrator 
 an rror occurs with an Agile portlet, you may see the following message appear: 

If you see such a message, th
Administrator. Click the link to o
message to the portal administrator. 

Note The portal administrator’s email address must be specified in the portalAdministratorEmail
application parameter. For more information, see “Setting Agile Portlet Services 
Application Parameters (on page 11)”. 
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 Troubleshooting

This chapter includes the following: 

 Error Conditions................................................................................................................................................... 77 
............................................................................................... 79 

 

tions ........................................................................................................................... 82 

ppears in the 

gile/ServerAPIProperties

 Configuring Portlet Applications and Portlets .......
 Agile PLM Privileges............................................................................................................................................ 80
 Searches.............................................................................................................................................................. 80 
 Business Object Portlet ....................................................................................................................................... 81 
 Importing Portal Configura

 
 

Error Conditions 
I get an APIException.getRootCause message for all portlets 

When you try to display any portlet, an APIException.getRootCause message a
portlet. 

Solution: 

1.  Make sure that the server.url parameter is correct and Agile PLM server is running. 

2.  Try to connect to http://plmserver.company.com:7777/A . If you can’t 
ect, there is a problem with the Agile PLM server. HTTP ports may be configured 

stently between the Agile PLM server and the Oracle Application Server (OAS). For 

up the cache, the portal administrator 
delete the AgileSDK.cache folder under c:\documents and 
p. 

 try to display any portlet, a “Cannot find bundle for base name 
.util.ejb.AGILE_JNDI” message appears in the portlet. 

This  by a problem connecting from the portal to your application server. Make 
sure

  
he server.url parameter. 

etails about HTTP port 

conn
inconsi
more details about HTTP port settings for OAS, see the Agile PLM Installation Guide. 

3.  If you updated the Agile PLM server or updated the Agile SDK JAR files, make sure you clean 
up the Agile SDK cache on the portal server. To clean 
should stop the Portal Server and 
settings\<user>\Local Settings\Tem

Cannot find bundle for base name com.agile.util.ejb.AGILE_JNDI 

When you
com.agile

Solution: 

 is probably caused
 

 You can ping the application server. 

You specified the fully qualified domain name of the application server when you installed Agile
PLM 9.2.2 and when you set portlet application parameters such as t

 HTTP ports are configured consistently on the application server. For d
settings for Oracle Application Server, see the Agile PLM Installation Guide. 
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 You are trying to connect to an Agile PLM 9.2.2 application server and not a server from a 
different Agile release. 

r may be using older class files and therefore cannot 
ect to the updated Agile PLM server. See “Clearing the Agile SDK Cache

 You have cleared the Agile SDK cache. If you updated the Agile Portlet Services WAR file on 
your portal server, your portal serve
conn  (on page 18)”. 

or upload files on WebSphere Portal Express 5.02, you get 

: Class javax/activation/DataHandler 

aders  

va/jre/lib/ext. 

.jar 

r.3 

java.lang.LinkageError: Class javax/activation/DataHandler 

When using Agile portlets to download 
the following exception: 

java.lang.LinkageError
violates loader constraints: definition mismatch between 
parent and child lo

The exception is caused by different versions of activation.jar being loaded within the classpath. 
The files conflict with the activation.jar file located in <was_root>/ja

Solution: 

To work around this problem, rename the following activation.jar files and give them unique names: 

<wps_root>/shared/app/activation.jar 

<wps_root>/wpcp/v5.0/author/lib/activation

For example, you can rename the first file activation.jar.2 and the second one activation.ja

Note Depending on your environment, you may need to rename other copies of 
activation.jar to prevent conflicts. Search for any copies of activation.jar under 
the WebSphere folder. Do not rename the copy in <was_root>/java/jre/lib/ext. 

This object has been modified, please refresh and try again 

n for a 
description of the error, and the following message box appeared: “This object has been modified, 

ving 

2.  Click Cancel to exit Edit mode and cancel your changes. 

You were unable to save changes to an object due to an error. You clicked the error ico

please refresh and try again.” 

Solution: 

The object was modified by another user after you entered Edit mode, preventing you from sa
your changes. To re-enter your changes, do the following: 

1.  Click OK in the message box to close it. 

3.  Click  Refresh to refresh the object with the latest data from the server. 

ose Actions > Edit to enter Edit mode. 

Save

 appears: “Cell 
[Title Block.Description] is read-only” 

When you add a file attachment to an object in the Business Object portlet, you may see this error if 
you do not have appropriate privileges for the File Folders class. The file attachment was added 
successfully, but the Title Block > Description field of the associated File Folder could not be updated. 

4.  Cho

5.  Re-enter your changes, and click . 

When I add a file attachment to an object in the Business Object portlet, an error
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Make sure you have Modify privileges to the Title Block > Description field for the File Folders class. 

Please select some BaseClasses first 

ject class on the Classes tab, and then clicked the 

you selected an object class, you did not click Add to define a class view. After you click 

You tried  “This 
Portlet In . Please use the Configure or Edit Mode to set the required 
configura

Solution: 

try to 

 application parameters, but you were unable to because the fields 

nown issue with WebSphere Portal 5.1.x. IBM Support has announced that it will be fixed 

nfiguration window for a portlet, 
s in your browser. 

the following URL: 

/webserver:port/configurator/configurator.jnlp

In the Portlet Configurator, I have selected an ob
Configure tab. An error message appears: “Please select some BaseClasses first!” 

Solution: 

Although 
Add, the portlet title you entered appears in the Defined Class Views list. 

This Portlet Instance has not been configured 

 to configure an Agile portlet in the page layout, and the following error appeared:
stance has not been configured
tion parameters.” 

The portlet can only be configured from a portal page by using Configure or Edit mode. Do not 
configure the portlet from the page layout. 

Configuring Portlet Applications and Portlets 
Editing AgilePortlets 2.1 Application Parameters 

You tried to edit AgilePortlets 2.1
are read-only. You can add new parameters, but you can’t edit any of the existing parameters. In 
WebSphere Portal 5.0.x, you could modify the parameters. 

Solution: 

This is a k
in the next version of the WebSphere Portal product. To edit an application parameter, you have to 
delete it first and then recreate it with the new information. 

I can’t launch the Portlet Configurator 

When you try to launch the Portlet Configurator from the XML Co
the application doesn’t launch, or the configurator.jnlp file appear

Solution: 

1.  Make sure the webClientVirtualPath portlet application parameter is correct. 

2.  Make sure the portletConfiguratorURL portlet application parameter is correct. It should point to 

http:/

3.  Make sure you copied the agile_home\Portlet_51\configurator or 
agile_home\Portlet_50\configurator  folder to your Web server’s docroot directory. On Intern
Information Services (IIS), the default doc root is c:\I

et 
netpub\wwroot. 

ake sure Java Runtime Environment (JRE) 1.4.2 or later is installed on the client computer. 

4.  Make sure you configured the JNLP MIME type for your Web server. 

5.  M
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After I configure a portlet and return to the page, the portlet takes up the entire page 

Sometimes after you configure a portlet, the portlet expands to fill the entire page e
are other portlets in the layout. 

ven though there 

Solution: 

w an Agile PLM object in a portlet, some fields display the value “No Privilege.” What 
 mean? How can you get privileges to see those fields? 

ermines whether the Read privilege is enforced for Agile 
e, 

y 

nistrator to change your user 
account so that the field-level Read privilege is not enforced. For more information, see the Agile 

The wildc ase. When you run a search with 
, the criteria must be matched against all words in the index, which can run into several 

Therefore, you should avoid creating wildcard searches that are 

e. 

A search that uses only an asterisk (*) for its criteria returns all records and is not subject to the 
maximum number of search results. 

Solution: 

If you see this error in the Search Results portlet, refine your search criteria and try again. Enter a 
more specific search string. For example, “Resistor*” is more specific than “R*”. 

Click the Restore icon in the portlet’s title bar to restore it to its proper size. 

Agile PLM Privileges 
Some fields display “No Privilege” 

When you vie
does that

Solution: 

The Enforce Field Level Read privilege det
PLM fields. If you have been assigned a role that includes the Enforce Field Level Read privileg
you may not be able to view the contents of specific fields. The words “No Privilege” appear in an
field for which you don’t have Read privileges. 

If you want to be able to view all fields, ask your Agile PLM admi

PLM Administrator Guide. 

Searches 
There were too many records found in your search. Please narrow down your search. 

ard search you ran matches too many rows in the datab
a wildcard
million rows on a large database. 
too broad and that match too many rows in the database, for example, a search for “R*”. 

By default, Agile PLM returns up to 1000 search results for any search. The Agile PLM 
administrator can increase the maximum number of search results, but doing so could adversely 
ffect system performanca
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Business Object Portlet 
All of my Business Object portlets are read-only 

You configured several different Business Object portlets, but they are all read-only. You can’t 
modify objects that appear in the portlets. How can you make Business Object portlets editable? 

Solution: 

When you configure the portlet, make sure the Edit action is included in one of the Action Groups. 
The XML configuration for Action Groups should look like this: 

<action-groups> 
  <action-group id="0" name="Custom Actions" groupMode="1" 
    collapseLimit="0" 
numberOfActionsToDisplayAsButtons="0"> 
    T<action id="9" ref-id="%common.edit" name="Edit"/>T 

  </action-group> 
</action-groups> 

If you prefer to make a Business Object portlet read-only for your portal, don’t include the Edit 
action in any of the portlet’s Action Groups. 

Of course, you can edit an object in Agile PLM only if you have the Modify privilege for that object. If 
you don’t have the Modify privilege, the Edit action is disabled. 

For more information, see “ TUAction GroupsUT (on page X40X)”. 

I cannot display the Gantt Chart 

From a Business Object portlet that displays program activities, you tried viewing the Gantt Chart by 
clicking the Gantt Chart action, but nothing happened, or you got the message “There is a problem 
logging into the Agile PLM Server. Please contact your administrator.” 

Solution: 

Make sure the TwebClientVirtualPathT portlet application parameter is correct. See “ TUSetting Agile Portlet 
Services Application ParametersUT (on page X11 X)”. 

To check whether the Web client path is correct, open a browser and type the TwebClientVirtualPathT 
value plus  
“T/PLMServlet T”. The Agile Web Client login screen should appear. 

I clicked the Assignment tab of a User Group, and the page displayed an error: “The system did not 
perform as expected.” 

You tried to display the Assignment tab of a User Group object in the Business Object portlet, but 
the page displayed an error. 

Solution: 

Log in as an portal administrator, and configure the Business Object portlet. Make sure the TUser 
Group > Assignment > Date Group TableT attribute is not selected for any attribute groups. The Date 
Group Table attribute is not supported by Agile portlets. 

When I create a new Affected Item for a Change, the popup window doesn’t display all required 
fields 
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You used the Business Object portlet to define a Change object, such as an ECO. On the Affected 
Items tab of the ECO, you clicked Create New to create a new part. However, the popup window 
that lets you create the part doesn’t display all of the required fields for that class. 

Solution: 

This is a known issue with the Business Object portlet. If you define Page Two or Page Three 
attributes to be required, they don’t appear in the popup window when you create a new part in the 
Affected Items tab of a Change. After you create the part, edit it to fill in the required fields. 

I configured the Business Object portlet to message to the page, but it is messaging to itself 

You set the Tportlet.messagingT parameter for a Business Object portlet to “page”. However, when you 
click a part in the BOM table, the portlet updates itself instead of messaging to other portlets on the 
same page. 

Solution: 

For objects supported by the Business Object portlet, the portlet overrides the Tportlet.messagingT 
parameter and always messages to itself. 

If you do not want the Business Object portlet to message to itself for a particular class, do not 
configure the portlet to support that class. However, the BOM table cannot message to the page 
because the table lists objects of the same class as the parent object, that is, other parts. Therefore, 
when you click a part on a BOM table, the portlet updates itself. 

Importing Portal Configurations 
I was not able to import a portal configuration successfully using the XML Configuration Interface 

You tried using the XML Configuration Interface to import a portal configuration, but it returned the 
following error: 

XMLA0009E: Could not connect to portal. 

Solution: 

Before trying to import a portal configuration that you exported using the XML Configuration 
Interface, remember to place the AgilePortletPack2.war file in the < Twps_rootT>\installableApps 
folder. For complete details on the XML Configuration Interface, see the IBM WebSphere Portal 
InfoCenter. 
 


	Copyright and Trademarks
	Introduction
	About Agile Portlet Services
	What’s New
	IBM WebSphere Portal Server
	Portlet Communication and Collaboration

	Installing and Upgrading Agile Portlet Services
	Installation Sequence
	Installing IBM WebSphere Portal
	Updating to WebSphere Portal 5.1.0.4
	Installing WebSphere Application Server and IBM HTTP Server as a Windows Service
	Web Server Considerations
	WebSphere Application Server Tuning
	Launching and Verifying the WebSphere Portal
	Configuring the WebSphere Portal for LDAP
	Creating Portal Users and User Groups

	Installing Agile Portlet Services
	Setting Agile Portlet Services Application Parameters
	Setting Application Parameters for Copies of Agile Portlets

	Setting Up the Agile Portlet Configurator
	Configuring the JNLP MIME Type
	Upgrading Agile Portlet Services to Agile PLM 9.2.2.3
	Using the XML Upgrade Tool
	Updating Agile Portlet Services
	Clearing the Agile SDK Cache
	Setting Agile Portlet Parameters
	Creating Portal Pages
	Editing the Layout of a Page
	Administering Pages
	Setting Resource Permissions
	Using Custom Themes and Skins

	Agile PLM Administration Settings Related to Portlets

	Configuring Agile Portlets
	About Portlet Configuration
	Portlet Modes
	Configuring the Advanced Search Portlet
	Configuring a Quick Links Portlet
	Setting Up Quick Links to Portal Pages

	Configuring the Report Folder Browser Portlet
	Using the Portlet Configurator
	Roles and Privileges Needed to Use Agile Portlet Configuratior
	Launching the Agile Portlet Configurator
	Portlet Configurator Toolbar
	Portlet Configurator Tabs
	Portlet Configurator Navigation
	Using Portlet Configurator to Modify a Configuration
	Using the Classes Tab
	Using the Configure Tab
	Attribute Groups
	Tables
	Action Groups
	Adding the Edit Action to an Actions Group
	Adding the Change Status Action to an Actions Group
	Adding the New Action to an Actions Group

	Portlet Layout

	Messaging Between Portlets
	Clearing Portlets If Messaging Is Not Supported

	Exporting and Importing Portal Configurations using the XML Configuration Interface
	Using Process Extensions from within Portlets
	Configuring a New Process Extension Action for a Portlet
	Testing a Sample Process Extension within a Portlet


	Creating Custom Help for Agile Portlets
	Downloading Online Help Files for Agile Portlets
	Configuring Online Help for Portlets on WebSphere Portal 5.1.0.4
	Configuring Online Help for Portlets on WebSphere Portal 6.012



	Using Agile Portlets
	Agile Portlet Features
	Using Edit Mode to Personalize Agile Portlets
	Filtering Data in Portlets
	Advanced Search Portlet
	Using Advanced Search
	OR Searches
	AND Searches
	AND NOT Searches
	Matching Exact Phrases

	Personalizing the Advanced Search Portlet
	Edit Mode Options
	Configure Mode Options


	Attachment Files Portlet
	Edit Mode Options
	Configure Mode Options

	Bookmarks Portlet
	Business Object Portlet
	Clipboard Portlet
	My Notifications Portlet
	Configure Mode Options

	My Things To Do Portlet
	Displaying Things To Do by Due Date
	Configure Mode Options


	Quick Links Portlet
	Edit Mode Options
	Configure Mode Options

	Quick Navigation Portlet
	Quick Search Portlet
	Using Wildcards
	Configure Mode Options

	Report Folder Browser Portlet
	Edit Mode Options
	Configure Mode Options


	Saved Search Portlet
	Configure Mode Options

	Search Folder Browser Portlet
	Edit Mode Options
	Configure Mode Options

	Search Results Portlet
	Single Signon Portlet
	Edit Mode Options

	Upload File Portlet
	Options

	User Profile Portlet
	Sending Portlet Errors to the Portal Administrator

	Troubleshooting
	Error Conditions
	Configuring Portlet Applications and Portlets
	Agile PLM Privileges
	Searches
	Business Object Portlet
	Importing Portal Configurations


